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Changing Help Preferences

By default, documentation access from TIBCO Business Studio™ for BusinessWorks™ is
online, through the TIBCO Product Documentation website that contains the latest version
of the documentation. Check the website frequently for updates. To access the product
documentation offline, download the documentation to a local directory or an internal web
server and then change the help preferences in TIBCO Business Studio for BusinessWorks.

Before you begin
Before changing the help preferences to access documentation locally or from an internal
web server, download the documentation.

1.
2.

6.

Go to https://docs.tibco.com/
In the Search field, enter TIBCO ActiveMatrix BusinessWorks™ and press Enter.

Select the TIBCO ActiveMatrix BusinessWorks™ product from the list. This opens the
product documentation page for the latest version.

Click Download All.

A compressed .zip file containing the latest documentation is downloaded to your
web browser's default download location.

Copy the .zip file to a local directory or to an internal web server and unzip the file.

To point to a custom location:

Procedure

1.

2.

Perform one of the following steps in TIBCO Business Studio for BusinessWorks based
on your operating system:

e On Windows OS: Click Window > Preferences

e On macOS: Click TIBCO Business Studio > Preferences.

In the Preferences dialog, click BusinessWorks > Help.

3. Click Custom Location, and then browse to the html directory in the folder where

you extracted the documentation or provide the URL to the html directory on your
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internal web server.

4. Click Apply, and then click OK.
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Installation Requirements

Before installing the product on your system, ensure that you can log in to the system with
appropriate permissions, and that your system meets the hardware and software
requirements need to install ActiveMatrix BusinessWorks™.

If you plan to install in an existing installation environment, stop all running processes in
TIBCO_HOME.

Installation Account

The privileges required to install the product differ for Windows and UNIX platforms.
Ensure that you have the appropriate privileges to install on the target platform.

Microsoft Windows

You must have administrator privileges for the machine on which you want to install the
software. If you do not have administrator privileges, the installer exits. If you want to
install the product on a network drive, ensure that the account used for installation has
permission to access the network drive.

Mac and UNIX

Any user, regular user (non-root) or super-user (root), can perform the installation. Use the
same user account to install all TIBCO products.

On Unix systems, a graphic environment such as CDE or X Windows is required to run the
installer in GUI mode.

Pre-installation Tasks

Pre-installation tasks include the tasks that you must complete before you start the
installer, such as ensuring your system meets the installation requirements and
customizing your environment for certain platforms.

TIBCO ActiveMatrix BusinessWorks™ Installation
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Download TIBCO ActiveMatrix BusinessWorks™ Software

Download the ActiveMatrix BusinessWorks™ software package for your platform from the
TIBCO Software Product Download Site (https://edelivery.tibco.com/). Extract the
ActiveMatrix BusinessWorks archive file to a temporary directory on the machine on which
you run the installer.

Required on Linux and Solaris: Download Eclipse LGPL Software
Assembly

If the Eclipse LGPL software assembly (product_tibco_eclipse_lgpl) is not present in the
temporary directory where you extracted the product archive file, and the machine on
which you want to run the ActiveMatrix BusinessWorks installer is not connected to the
internet, download the Eclipse LGPL software assembly for your target platform before you
install ActiveMatrix BusinessWorks.

Save the downloaded assembly in a temporary directory accessible to the machine on
which you run the installer. During installation, provide the location of the temporary
directory where the downloaded software assembly is available.

If the machine is connected to the internet, you can download the Eclipse LGPL software
assembly file for your target platform from the TIBCO Software Product Download Site
during installation. The product_tibco_eclipse_lgpl_3.7.2.001_0Splatform.zip is
downloaded to the location you select.

Optional: Download Sunec LGPL Software Assembly

The software requires the Sunec LGPL library (Oracle Elliptic Curve Cryptography (ECC)
Library) only if you want to use the ECC ciphers with SSL/TLS configurations. Without the
ECC library, the SSL/TLS functionality is still available, but without ECC ciphers.

If the Sunec LGPL software assembly (product_tibco_sunec) is not present in the
temporary directory where you extracted the product archive file, and the machine on
which you run the installer is not connected to the Internet, download the Sunec LGPL
software assembly for your target platform before you install ActiveMatrix BusinessWorks.

Save the downloaded assembly in a temporary directory accessible to the machine on
which you run the installer. During installation, provide the location of the temporary
directory where the downloaded software assembly is available.

If the machine is connected to the Internet, you can download the Eclipse LGPL software
assembly file for your target platform from the TIBCO Software Product Download Site
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during installation. The product_tibco_sunec_1.7.0.072_0Splatform.zip is downloaded
to the location you select.

Hardware and Software Requirements

Review the system memory and disk space requirements before you start the installation.

While installing the product, avoid running other processes that consume disk space in the
installation environment directory. If another process consumes disk space while the
installer is copying the files, the installer might fail and display a failure message.

System and Disk Space Requirements

The product readme file specifies the system memory and disk space required for
installation. In addition to the disk space in the temporary directory before installation, the
installer requires additional space in the temporary directory to copy files during
installation. Ensure that sufficient space is available in the directory you want to use as the
installation environment, your T/IBCO_HOME.

o Note: If you want to run scripts, make sure that the T/IBCO_HOME path does not
contain any spaces, such as: Program Files.

o Important: See the readme file for information about the system and disk space
requirements, supported operating system platforms and versions, and required
patches, if any.

Software Requirements

Before running the installer on a target platform, ensure that the platform is supported and
your system meets the software requirements.

Important: Unless indicated otherwise, see the readme file for the supported
products and versions.

TIBCO ActiveMatrix BusinessWorks™ Installation
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Required Software

Software

Eclipse
components

Sunec LGPL

Description

Required. On some operating system platforms, TIBCO Universal Installer
automatically downloads certain Eclipse LGPL components during
installation, if necessary. However, on Linux and Solaris platforms, you must
download the Eclipse LGPL software assembly for your target platform
before installing the software. For more information, see Pre-installation
Tasks.

Optional. The software requires the Sunec LGPL library only if you want to
use the ECC ciphers with SSL/TLS configurations. Without the ECCL library,
the SSL/TLS functionality is still available, but without ECC ciphers.

You must download the Sunec LGPL software assembly for your target
platform before installing the software. For more information, see Pre-
installation Tasks.

Compatibility Chart for TIBCO ActiveMatrix
BusinessWorks™ and TIBCO® Enterprise
Administrator

The TIBCO Enterprise Administrator (TEA) server is an application administration Ul that
supports multiple TIBCO products, including the ActiveMatrix BusinessWorks™. Using the
Admin Ul you can create, view, and monitor runtime entities. Each product registers its
own agent with the server and the server communicates with the products through these
agents. The compatibility rules and chart help determine the minimum version of the TEA
server required by a given version of ActiveMatrix BusinessWorks.

These are the compatibility rules for the TEA server and TEA agent libraries:

e The TEA server is backward compatible with earlier versions of TEA agent libraries,
unless there is a known issue.

e The TEA server does not guarantee forward compatibility with newer versions of TEA
agent libraries.

TIBCO ActiveMatrix BusinessWorks™ Installation
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The following table lists the version of the TEA agent library bundled with a given version
of ActiveMatrix BusinessWorks.

ActiveMatrix BusinessWorks Version Version of TEA Agent Library Bundled

6.4.2 2.1.0 HF-002
6.5.0 2.1.0 HF-002
6.5.1 2.3.0 HF-005
6.6.0 2.3.0 HF-007
6.6.1 2.3.0 HF-007
6.7.0 2.4.0
6.8.0 2.4.0

Compatibility Chart

Based on compatibility rules and the version of the TEA agent library bundled in a given
version of ActiveMatrix BusinessWorks, see the following compatibility chart:

ActiveMatrix BusinessWorks Version with TEA Agent TEA Server Version
Library Version
2.3.0 HF- 2.3.0 HF- 2.4.0

005 007

ActiveMatrix BusinessWorks 6.5.1 with TEA Agent Library
2.3.0 HF-005

ActiveMatrix BusinessWorks 6.6.0 with TEA Agent Library
2.3.0 HE-007 X

TIBCO ActiveMatrix BusinessWorks™ Installation
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ActiveMatrix BusinessWorks Version with TEA Agent TEA Server Version
Library Version
2.3.0 HF- 2.3.0 HF- 2.4.0
005 007

ActiveMatrix BusinessWorks 6.6.1 with TEA Agent Library
2.3.0 HE-007 X x

ActiveMatrix BusinessWorks 6.7.0 with TEA Agent Library . .

ActiveMatrix BusinessWorks 6.8.0 with TEA Agent Library . .

TIBCO ActiveMatrix BusinessWorks™ Installation
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Installation

TIBCO provides downloadable product archive files and the products can be installed using
TIBCO Universal Installer.

Extract the downloaded product archive file to a temporary directory, and then run the
TIBCO Universal Installer executable from that directory.

Note: If installing more than one product, you can extract multiple product
archive files to the same temporary directory and then run TIBCO Universal

Installer.

TIBCO ActiveMatrix BusinessWorks™ Installation
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Installation Modes and Procedures

You can run the TIBCO Universal Installer in GUI, console, or silent mode. Each mode is
supported on all platforms. Ensure that your system meets all the requirements described
in the Installation Requirements.

Installation Description Reference
Mode
GUI In GUI mode, the installer contains panels where you can Installing in

select a product, product location, and so on. To invoke the ~ GUI Mode
installer in GUI mode, double-click the executable file.

Console In console mode, you can run the installer on a command Installing in
line. This is useful if your machine does not have a GUI Console
environment. Mode

Silent In silent mode, the installer installs the product without Installing in
prompting you for information. The installer uses either Silent Mode

default or custom settings that are saved in a response file.

Installing in GUI Mode

When you run the installer in GUI mode, the installer presents panels that you can use to
choose the installation environment and customize your installation.

Before you begin

If you want to install TIBCO ActiveMatrix BusinessWorks™ Maven Plugin, install Apache
Maven from https://maven.apache.org/download.cgi and set Maven home in the
Environment Variables.

Procedure
1. Run the TIBCOUniversallnstaller executable.

TIBCO ActiveMatrix BusinessWorks™ Installation
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e On Microsoft Windows: TIBCOUniversalInstaller.exe

e On Unix: TIBCOUniversalInstaller.bin

e On Mac OS: TIBCOUniversalInstaller-mac.command

2. On the Welcome screen, click Next.

3. Read the license agreement, select | accept the terms of the license agreement if
you agree to the terms, and click Next.

4. Choose to create a new installation environment that is be your TIBCO_HOME and
specify the path to the new environment. If you want to run scripts, make sure that
the TIBCO_HOME path does not contain any spaces, such as Program Files. Then

click Next.

Option

Create a
hew
TIBCO_
HOME

Use an
existing
TIBCO_
HOME

Procedure

In the Directory field, specify the directory into which the product is
installed. The directory cannot be the same as the directory of an existing
installation environment.

The directory path cannot contain the following special characters:

HS%&*<>7" |

Note: If you want to run scripts, make sure that the TIBCO_HOME path
does not contain any spaces, such as: Program Files.

Select an existing installation environment from the drop-down menu.

Note: If you want to run scripts, make sure that the TIBCO_HOME path
does not contain any spaces, such as: Program Files.

Important: If you are upgrading to the latest version of the software
from an earlier version, it is good practice to install the latest version
in the same installation environment.

5. On the Installation Profile Selection screen, select one or more of the pre-configured
profiles, or click Customize Installation, and explicitly select the components you
want to install. By default, the pre-configured profiles include the Oracle Elliptic

TIBCO ActiveMatrix BusinessWorks™ Installation
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Curve Cryptography Library (ECCL) component. The software requires the ECCL
only if you want to use the ECC ciphers with SSL/TLS configurations. Without the
ECCL, the SSL/TLS functionality is still available, but without the ECC ciphers.

TIBCO Universal Installer X

]
I I B‘ 9 Installation Profile Selection 0
Runtime [=}+ | BusinessWorks Design
- [«] Desian

=} | BusinessWorks Maven Plugin

BusinessWorks Runtime

|7| Runtime
“ [«] Oracle Elliptic Curve Crvptoaraphy Library

Customize Installation

EXCHANGE ANSWERS AND IDEAS AT TIBC9 COMMUNITY

community.tibco.com|
’T;k‘ Cancel Next

e If you want to install TIBCO ActiveMatrix BusinessWorks™ Maven Plugin, select
the Customize Installation and Maven Plugin check boxes and then click Next.

e If you do not plan to use the ECC ciphers, you do not need to download and
install the ECCL. Select the check box Customize Installation and clear the
check box for the Oracle Elliptic Curve Cryptography Library component.
Then click Next.

e To continue with the default selection, click Next.

6. On Linux and Solaris, the design feature requires Eclipse LGPL assembly to be
available in the temporary directory prior to installation. For more information, see
Software Requirements. The installer prompts the LGPL License Agreement screen for
the Eclipse LGPL assembly. Read the license agreement, select | accept the terms of
the license agreement if you agree to the terms, and click Next to proceed.

7. On the LGPL Assembly Download screen, select one of the following download
options and click Next.

» Download Gnome Binding assembly from TIBCO: Select this option if you are

TIBCO ActiveMatrix BusinessWorks™ Installation
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8.

10.

connected to the Internet or do not want to use a previously downloaded
assembly. The assembly is automatically downloaded and stored in the
assemblies subdirectory of the directory where you extracted the installer.

e Provide the location for the assembly previously downloaded from TIBCO:
Select this option if you are not connected to the Internet. Click Browse to
navigate to the directory where the previously downloaded LGPL assembly is
stored. Select the directory, and click Open.

o Note: Skip this step if the Oracle Elliptic Curve Cryptography Library
component was not selected in the Installation Profile Selection screen.

If you choose to install the Oracle Elliptic Curve Cryptography Library component,
the design feature requires the Sunec LGPL assembly to be available in the
temporary directory prior to installation. See Software Requirements for details. The
installer prompts the LGPL License Agreement screen for the Sunec LGPL assembly.
To download the Oracle Elliptic Curve Cryptography Library, select | accept the
terms of the license agreement, and click Next. If you do not want to download the
Oracle Elliptic Curve Cryptography Library, click Cancel to exit.

On the LGPL Assembly Download screen, select one of the following download
options and click Next.

» Download Oracle Elliptic Curve Cryptography Library assembly from TIBCO:
Select this option if you are connected to the Internet or do not want to use a
previously downloaded assembly. The assembly is automatically downloaded
and stored in the assemblies subdirectory of the directory where you extracted
the installer.

e Provide the location for the assembly previously downloaded from TIBCO:
Select this option if you are not connected to the Internet. Click Browse to
navigate to the directory where the previously downloaded LGPL assembly is
stored. Select the directory, and click Open.

On the Pre-Install Summary screen, verify the list of products and components
selected for installation, and click Install.

11. Verify the Post-Install Summary, click Finish to complete the installation process, and

close the installer window.

TIBCO ActiveMatrix BusinessWorks™ Installation
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o Note: If you want to install Maven Plugin after installing TIBCO ActiveMatrix
BusinessWorks™ in the GUI mode, double-click the TIBCO Universal Installer file
to start installation. Select Customize Installation and Maven Plugin check
boxes and clear the other check boxes to continue the installation of Maven

Plugin.

Installing in Console Mode

When you run the installer in console mode, the installer prompts for values on a console
window and you can move through the installation by responding to the prompts. The
Console mode can be used to install the software in a non-Windows environment.

Before you begin
» Prepare your system and the installation media before running the installer in
console mode.

* If you want to install TIBCO ActiveMatrix BusinessWorks™ Maven Plugin, install
Apache Maven from https://maven.apache.org/download.cgi and set Maven home in
the Environment Variables.

Procedure
1. Open a console window and navigate to the temporary directory where you extracted

the product archive file.
2. Run the installer using one of the following commands:

e On Windows:

Run TIBCOUniversallInstaller -console

The installer launches a second console window.

e On UNIX:

Run ./TIBCOUniversalInstaller.bin -console

e On Mac OS:

TIBCO ActiveMatrix BusinessWorks™ Installation
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Run . /TIBCOUniversallInstaller-mac.command -console

3. Complete the installation by responding to the console window prompts, which are
similar to those described in the section Installing in GUI Mode. The console also
provides an option to return to a previous selection periodically.

o Note:

 If you want to run scripts, make sure that the TIBCO_HOME path
does not contain any spaces, such as: Program Files.

* To install Maven Plugin in the console mode, select the Customize
Installation and then Maven Plugin options.

4. When the installation is completed, press Enter to exit the installer.

o Note: If you want to install the Maven Plugin after installing TIBCO ActiveMatrix
BusinessWorks™ in the console mode, run the installer again. Select Customize
Installation and then Maven Plugin options, and clear the other options to
continue the installation of Maven Plugin.

Installing in Silent Mode

When you run the installer in silent mode, the installer does not prompt for your input.
Instead, the values specified in a response file are used to complete the installation. You
can use a default pre-configured response file or create your own response file.

By default, the installer uses the TIBCOUniversalInstaller_BW_
<version>.silentTIBCOUniversalInstaller_bwx_<version>.silent file, which is
included in the directory that contains the universal installer.

To customize the silent installer:

» Make a backup copy of the TIBCOUniversalInstaller_BW_
<version>.silentTIBCOUniversalInstaller_bwx_<version>.silent file and edit
the file itself. You can then run the silent installer with or without the response file
argument.

TIBCO ActiveMatrix BusinessWorks™ Installation
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Before you begin

If you want to install TIBCO ActiveMatrix BusinessWorks™ Maven Plugin, install Apache
Maven from https://maven.apache.org/download.cgi and set Maven home in the
Environment Variables.

Procedure

1. Make a copy of TIBCOUniversalInstaller_BW_
<version>.silentTIBCOUniversalInstaller_bwx_<version>.silent file and
rename the file, for example, newfile.silent.

2. Using a text editor, open the copied file and update the installation location and
features to install.

o Note: If you want to run scripts, make sure that the T/BCO_HOME path
does not contain any spaces, such as: Program Files.

3. Open a console window, and navigate to the temporary directory where you
extracted the product archive file. Run the silent installer using one of the following

commands:

e On Windows:

TIBCOUniversalInstaller.cmd -silent -V responseFile="newfile.silent"

e On UNIX:

TIBCOUniversallInstaller.bin -silent -V responseFile='newfile.silent'

e On Mac OS:

TIBCOUniversalInstaller-mac.command -silent -V
responseFile="newfile.silent'

TIBCO ActiveMatrix BusinessWorks™ Installation
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o Note:

e To install Maven Plugin in the silent mode, set Maven Plugin to 'true'.

* If you want to install the Maven Plugin after installing TIBCO ActiveMatrix
BusinessWorks™ in the silent mode, run the silent installer again. Set

Maven Plugin to 'true' and other options to 'false' to continue the
installation of Maven Plugin.

TIBCO ActiveMatrix BusinessWorks™ Installation
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Troubleshooting Installation

If you encounter problems with the installation or uninstallation, first ensure that your
system meets all requirements. Next, check the installer log for potential problems.

The installer log file, tibco_universal_installer.username_install.log, is available at
the following locations:

Platform Location
Microsoft Windows C:\Users\username\.TIBCO\install_timestamp
Linux user_home_dir/.TIBCO/install_timestamp

macOS Users/user_home_dir/.TIBCO/install_timestamp

The installer log file captures the following information:

 Detailed information regarding the user that invoked the installer, hostname,
operating system details, and so on

e List of assemblies installed

e Information related to the Ant scripts executed by the installer

To change the location of the installer log file, specify the option -V logFile="myLogFile"
when you run the installer.

TIBCO ActiveMatrix BusinessWorks™ Installation
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Post Installation Tasks

Post installation tasks are additional tasks that you might have to perform after
installation. These tasks are required for certain scenarios and must be performed before
you develop your applications or create and configure the runtime objects.

Before you begin
Complete the installation before running the post installation tasks.

o Note: In case Apache Maven is not installed before installing TIBCO ActiveMatrix
BusinessWorks™ Maven Plugin, install Apache Maven and then run
install.sh/install.bat from <TIBCO-HOME>\bw\6.x\maven to install Maven
Plugin.

Set Environment Variable Rv_HOME

If you want to use the Rendezvous palette activities, install TIBCO Rendezvous®. For the
supported versions, see the product readme file.

Important: Ensure that the environment variable RV_HOME is set and refers to
the TIBCO Rendezvous installed. For example, on Windows platform, set "RV_
HOME=TIBCO_HOME/tibrv/8.4".

On AIX Platform: Configure the Environment
On AIX platform, follow the steps to configure the environment:

1. Remove TIBCO_JRE_HOME/1.8.0/1lib/xml.jar.

2. Copy BW_HOME/system/shared/com.tibco.tpcl.javax.system.exports_
5.10.0.001/xml-apis.jar into TIBCO_JRE_HOME/1.8.0/1lib/ext

3. Copy BW_HOME/system/shared/com.tibco.tpcl.com.ctc.wstx_3.2.300.002/wstx-
asl-3.2.9.jar into TIBCO_JRE_HOME/1.8.0/1ib/ext

TIBCO ActiveMatrix BusinessWorks™ Installation
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4. To resolve localhost on AIX platform, add the property [hosts = local, bind4] to
/etc/netsvc.conf if applicable.

Note: If you are using BWAgent with TEA, TEA_HOME and BW_HOME locations
must be different.

Integrating with TIBCO Enterprise Message
Service™

Before you begin
Make sure that the TIBCO Enterprise Message Service™ client OSGi bundles are present in
the <EMS_HOME>/components/shared/1.0/plugins folder.

o Note: The plugins folder that you specify for TIBCO Enterprise Message Service™
must contain only the TIBCO Enterprise Message Service™ client OSGi bundles.

Note: In case the plugins folder contains additional library jars, copy the TIBCO
Enterprise Message Service™client OSGi bundles to a temporary folder. Use this
temporary folder path as input for bwinstall ems-driver.

For driver jars, see the following figure.

TIBCO ActiveMatrix BusinessWorks™ Installation
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Name

» || _installinfo
v [ | components
v || shared

v [ 1.00
p [ features
4

[ plugins
Il com.tibco.jms.jmsclient_8.3.0.014
Bl com.tibco.jms.jmsclient.admin_8.3.0.014

Il com.tibco.jms.jmsclient.rv_8.3.0.014
Bl com.tibco.jms.jmsclient.ufo_8.3.0.014
Il com.tibco.tpcl.javax.jms_2.0.0.002
.DS_Store
.DS_Store
.DS_Store
] config

] ems

|| release_notes

vvvyywyy

| tools

If you do not have these client libraries, install the TIBCO Enterprise Message Service™
libraries by selecting either the Development or Client installation profiles.

® TIBCO Universal installer

Installation Profile Selection

Choose one or more installation profiles from the list on the lefi. You can customize the profile
feature settings by checking the "Customize Installation’ checkbox and using the feature tree on the

1) Development [

Customize Installation [

This installation profile will install the components needed to run an EMS Clent.

fack ] Next |  Cancel

Alternatively, copy the <EMS_HOME> /components folder from an existing installation to your
local machine.

Installing TIBCO Enterprise Message Service™ Client Libraries

To install the TIBCO Enterprise Message Service™ client libraries for your ActiveMatrix
BusinessWorks environment, run the following command from the <Bw_HOME> /b-in folder
and follow the prompts:

TIBCO ActiveMatrix BusinessWorks™ Installation
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bwinstall ems-driver

Setting Up TIBCO FTL® for BWAgent Transport

Follow these instructions to set up TIBCO FTL for BWAgent transport.

o Important: Note the following items:

» Refer to the TIBCO ActiveMatrix BusinessWorks™ readme for the version of
TIBCO FTL that is supported with the version of ActiveMatrix
BusinessWorks™ 6.x you are using.

* If you are installing TIBCO FTL after you have already installed ActiveMatrix
BusinessWorks, set the tibco.env.FTL_HOME variable in the bwcommon.tra
file. You can find this file in the bin folder at Bw_HOME\b-in for Windows, or
${BW_HOME} /bin for Unix.

* Ensure you have installed FTL client libraries. For more information, see
Integrating with TIBCO FTL.

Procedure
1. Install TIBCO FTL. For more information, see the TIBCO FTL® Installation guide.

2. Start the FTL Realm server by executing the ./tibrealmserver -ht <hostIP>:<port> FTL
command.

./tibrealmserver -ht <hostiP>:<port>

3. To populate data in the bwadmin_ftlrealmserver.json template file, located in the
BW_HOME / config folder, execute the following FTL command:

For FTL 5.x,

./tibrealmadmin -rs <realmserverurl> —ur <PATH of bwadmin_ftl_realmserver.json>

For FTL 6.x,

TIBCO ActiveMatrix BusinessWorks™ Installation
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./tibftlmadmin —--ftlserver <realmserverurl> —ur <PATH of bwadmin_ftl_
realmserver.json>

4. Optional. If you are upgrading from ActiveMatrix BusinessWorks 6.4.x/6.5.x/6.6.x to
ActiveMatrix BusinessWorks 6.7.0, and you use FTL, use the bwadmin_
ftlrealmserver.json_orig file.

Tip: For instructions on how to configure an FTL backup server for high
availability, see "Configuring Backup Realm Servers for Fault Tolerance" in TIBCO
FTL® Administration.

Integrating with TIBCO FTL

To install the TIBCO FTL client libraries for your TIBCO ActiveMatrix BusinessWorks™
environment, follow instructions in either of the following sections.

Before you begin
The base version required is TIBCO FTL 5.2.1.

Using the bwinstall Utility
To install the TIBCO FTL client libraries for your ActiveMatrix BusinessWorks™ environment,
run the following command from the <Bw_HOME> /b+in folder and follow the prompts:

bwinstall ftl-driver

Using the TIBCO Universal Installer

Use the TIBCO ActiveMatrix BusinessWorks™ Plug-in for TIBCO FTL® to install the TIBCO FTL
client libraries for your ActiveMatrix BusinessWorks environment.

Note: The FTL palette and the activities in the palette are available at design
time and run time, after the plug-in is installed.
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Procedure
1. Run the TIBCOUniversallnstaller executable.

2. On the Welcome screen, click Next.

3. Read the license agreement, select | accept the terms of the license agreement if
you agree to the terms, and click Next.

4. Choose to create a new installation environment in an existing TIBCO_HOME. Specify
the location that ActiveMatrix BusinessWorks is installed. Then click Next.

5. On the Installation Profile Selection screen, ensure Typical is selected, and click Next.

TIBCO Universal Installer x

I I B‘ 9 Installation Profile Selection e
Runtime E|l TIBCO ActiveMatrix BusinessWorks(TM) Plug-in for FTL Runtime
Em_ © [ runtime

EI. TIBCO ActiveMatrix BusinessWorks{TM) Plug-in for FTL Design
design

Customize Installation [

EXCHANGE ANSWERS AND IDEAS AT TIBC® COMMUNITY

_pcommunity.tibco.comj.
coxdl | Next

6. Provide the TIBCO_HOME path where you installed TIBCO FTL, and click Next.
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TIBCO Universal Installer »

@-
TI BCQ TIBCO Home location where FTL is installed

Please provide TIBCO Home location where FTL has been installed

TIBCO Home location where FTL has been ins...

| | Browse

Cancel

7. On the Pre-Install Summary screen, verify the list of products and components
selected for installation, and click Install.

8. Verify the Post-Install Summary, click Finish to complete the installation process, and
close the installer window.
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Upgrading

You can upgrade to a higher version of the software when new features are available or
when problems in the software have been fixed. Typical steps include downloading and
installing the newer version of the software, and some manual tasks to complete the
upgrade. The manual tasks consist of generic tasks required for all versions and some
additional tasks that depend on the version you are upgrading to.

Upgrading from Version 6.4.x to Version 6.5.0

Upgrading from Version 6.4.x/6.5.0 to Version 6.5.1

Upgrading from Version 6.4.x/6.5.x to Version 6.6.0

Upgrading from Version 6.4.x/6.5.x/6.6.0 to Version 6.6.1
Upgrading from Version 6.4.x/6.5.x/6.6.x to Version 6.7.0
Upgrading from Version 6.4.x/6.5.x/6.6.x/6.7.x to Version 6.8.x
Upgrading from Version 6.4.x/6.5.x/6.6.x/6.7.x/6.8.x to Version 6.9.0

Upgrading from Version 6.4.x to Version 6.5.0

These instructions apply if you are upgrading from version 6.4.x to version 6.5.0.

Before you begin
» The base version required for this upgrade scenario is 6.4.0 or higher.

Complete these steps:

1. Back up the domains from the command line, or the Admin Ul.

o Important: Before you back up your domains, ensure that all
runtime artifacts have been stopped, and are not running.

To back up a domain, open a console window and navigate to the TIBC0_
HOME /bw/<older_version>/bin directory. Then run the following command:
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bwadmin backup -s <destination_file>.cmd domain <domain_name>

The bwadmin command file <destination_file>.cmd is generated.

If you are restoring to a different location, you need to update the command
file as follows:

°© The BWAgent name points to localhost by default; you need to change
this to the name of the machine you are restoring to.

° Update the domain home to point to the absolute path to the new
location.

o Update the path to the application archive (EAR) file to an absolute path.

For more information, see "Backing Up and Restoring a Domain" in T/IBCO
ActiveMatrix BusinessWorks™ Administration.

2. Delete domains from the command line, or the Admin Ul.

o Note: Deleting a domain cleans up the database entries. The entries
are repopulated when you restore the domain in the new upgraded
version.

3. Stop the BWAgent.

Procedure
1. Install the software in the same TIBCO_HOME directory.

Follow the instructions in Installation section to install the software in a same TIBCO_
HOME directory using GUI, console, or silent mode.

The installer copies the following files, if they are present, from the T18C0_
HOME /bw/6.x/config/ folder to TIBCO_HOME /bw/6.5/config/ folder and renames the
new files as they are with the _orig suffix.

e bwagent_as.json
e bwagent_db.json
e bwadmin_ftlrealmserver.json

e bwagent_ftl.json
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jaas.login.conf

realm.properties

krb5.conf

e mashery.ini
e logback.xml

2. Optional. If you have made manual updates to configuration files, or .tra files, copy
them from your previous TIBCO_HOME to the appropriate locations in your new
TIBCO_HOME.

3. Update the bwagent.ini file by running the config command with the -cf option.
The command changes based on how the BWAgent is configured for data persistence
and transport.

If the BWAgent is configured to use TIBCO ActiveSpaces, run the following command.

bwadmin config -cf ../config/bwagent_as.json agent

If the BWAgent is configured to use an external database and TIBCO Enterprise
Messaging Service, run the following command.

bwadmin config -cf ../config/bwagent_db.json agent

If the BWAgent is configured to use an external database and TIBCO FTL for data
persistence and transport, run the following command.

bwadmin config -cf ../config/bwagent_ftl.json agent

Note: Use bwagent_as/db/ftl.json_orig file if you want to use new
features like Process Monitoring.

4. Optional. Ensure third party JDBC drivers are installed.

If you want to use other databases, other than PostgreSQL or Microsoft SQL Server,
you must add them separately. This is a one time process for every installation of
ActiveMatrix BusinessWorks. Open the README.txt in the respective database shells
at BW_HOME /config/drivers/shells/ for details on what JAR files to download, and
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where to add them.

To add the drivers at run time for Oracle, MySQL or DB2, run the bwinstall
command from <BW_Home>/6.x/bin. Ensure that you run bwinstall with no
arguments to access the help and instructions to add the driver to the run time. For
more information, see "Installing Supported Drivers for Run Time" in TIBCO
ActiveMatrix BusinessWorks™ Bindings and Palettes Reference.

o Note: If you had already installed third party JDBC drivers in the previous
version of ActiveMatrix BusinessWorks 6.3.x/6.4.x, the drivers do not need
to be re-installed.

5. Install EMS client libraries to use activities from the JMS palette, or the BWAgent
with a database and TIBCO Enterprise Message Service (EMS) for persistence and
transport. For instructions about how to configure the EMS client libraries, see
Integrating with TIBCO Enterprise Message Service™.

6. Install FTL client libraries to use the activities from the FTL palette, or if the BWAgent
is configured to use the dbftl mode. For instructions about how to configure the FTL
client libraries, see Integrating with TIBCO FTL .

7. Start the BWAgent.

8. Restore the domains.

By default, the runtime components are installed under the TIBCO_HOME /bw/<new_
version> directory and the runtime artifacts such as domains, AppSpaces, and
AppNodes are created under the TIBCO_HOME /bw/<new_version>/domains directory.
If you want to use the runtime artifacts created using the older version of the
software, you can restore the runtime artifacts for the newer version of the software.
Complete the following tasks to restore the runtime artifacts to the new
environment:

Note: You also have the option to re-create the runtime artifacts. For
details on recreating runtime artifacts, see "Administration Tasks and
Reference" section of TIBCO ActiveMatrix BusinessWorks™ Administration.

a. Before restoring the domain, edit the <destination_file>.cmd as described:

e Inthe create -agent command, update the argument domainHome to
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provide the TIBCO_HOME /bw/<new_version>/domains directory.

e In the upload -domain command, update the location of the archive file
to provide the absolute path to the archive file. For example, update the
upload -domain command to the following:

upload -domain BookStore-Domain <7iBco_HOME>/bw/<old_
version>/bin/archives/BookStore-
Domain/tibco.bw.sample.binding.rest.BookStore.application_1.0.0.ear

o Note: You also have the option to import the TIBCO Business Studio
for BusinessWorks projects to a new workspace.

After installing the latest version of the software, use a new TIBCO
Business Studio for BusinessWorks workspace when developing
applications, modules, or rebuilding archive files. To use projects
created in the older version, import the projects to the new
workspace using the File > Import... menu in TIBCO Business Studio
for BusinessWorks. Reusing an existing workspace with the newer
version of the software makes that workspace unusable with the
older version of the software.

o Note: If the agent name is specified as localhost in the command
file, update it to specify the BWAgent name. The BWAgent name
(bw.agent.memberName) is the specified in the bwagent.ini file.

b. To restore the domain, or other runtime entities, in the new TIBCO_HOME
environment, navigate to the TIBCO_HOME /bw/<new_version>/bin on the
console, and run the following command:

bwadmin -f <destination_file>.cmd
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o Note: If you encounter issues with the TIBCO ® Enterprise
Administrator web client Ul, stop the TIBCO ° Enterprise
Administrator server, clean up the sr folder under STEA_
ConfigHome/tibco/cfgmgmt/tea/data/sr , and restart the TIBCO °
Enterprise Administrator server.

What to do next
After you have completed the upgrade, import your projects to a new workspace and

confirm all of your applications are running properly.

Note: Reusing an existing workspace with the newer version of the software
makes that workspace unusable with the older version of the software.

Upgrading from Version 6.4.x/6.5.x to Version
6.5.1

These instructions apply if you are upgrading from version 6.4.x/6.5.x to version 6.5.1.

Before you begin
» The base version required for this upgrade scenario is 6.4.0 or higher.

e Complete these steps:

1. Back up the domains from the command line, or the Admin Ul.

o Important: Before you back up your domains, ensure that all
runtime artifacts have been stopped, and are not running.

To back up a domain, open a console window and navigate to the TIBC0O_
HOME /bw/<older_version>/bin directory. Then run the following command:

bwadmin backup -s <destination_file>.cmd domain <domain_name>

The bwadmin command file <destination_file>.cmd is generated.
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If you are restoring to a different location, you need to update the command
file as follows:

° The BWAgent name points to localhost by default; you need to change
this to the name of the machine you are restoring to.

° Update the domain home to point to the absolute path to the new
location.

o Update the path to the application archive (EAR) file to an absolute path.

For more information, see "Backing Up and Restoring a Domain" in T/IBCO
ActiveMatrix BusinessWorks™ Administration.

2. Delete domains from the command line, or the Admin Ul.

o Note: Deleting a domain cleans up the database entries. The entries
are repopulated when you restore the domain in the new upgraded
version.

3. Stop the BWAgent.

Procedure
1. Install the software in the same TIBCO_HOME directory.

Follow the instructions in Installation section to install the software in a same TIBCO_
HOME directory using GUI, console, or silent mode.

The installer copies the following files, if they are present, from the T18C0_
HOME /bw/6.x/config/ folder to TIBCO_HOME /bw/6.5/config/ folder and renames the
new files as they are with the _orig suffix.

e bwagent_as.json

bwagent_db.json

bwadmin_ftlrealmserver.json

bwagent_ftl.json

jaas.login.conf

realm.properties

krb5.conf
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e mashery.ini
e logback.xml

2. Optional. If you have made manual updates to configuration files, or .tra files, copy
them from your previous TIBCO_HOME to the appropriate locations in your new
TIBCO_HOME.

3. Update the bwagent.ini file by running the config command with the -cf option.
The command changes based on how the BWAgent is configured for data persistence
and transport.

If the BWAgent is configured to use TIBCO ActiveSpaces, run the following command.

bwadmin config -cf ../config/bwagent_as.json agent

If the BWAgent is configured to use an external database and TIBCO Enterprise
Messaging Service, run the following command.

bwadmin config -cf ../config/bwagent_db.json agent

If the BWAgent is configured to use an external database and TIBCO FTL for data
persistence and transport, run the following command.

bwadmin config -cf ../config/bwagent_ftl.json agent

Note: Use bwagent_as/db/ftl.json_orig file if you want to use new
features like Process Monitoring.

4. Optional. Ensure third party JDBC drivers are installed.

If you want to use other databases, other than PostgreSQL or Microsoft SQL Server,
you must add them separately. This is a one time process for every installation of
ActiveMatrix BusinessWorks. Open the README.txt in the respective database shells
at BW_HOME /config/drivers/shells/ for details on what JAR files to download, and
where to add them.

To add the drivers at run time for Oracle, MySQL or DB2, run the bwinstall
command from <BW_Home>/6.x/bin. Ensure that you run bwinstall with no
arguments to access the help and instructions to add the driver to the run time. For
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more information, see "Installing Supported Drivers for Run Time" in TIBCO
ActiveMatrix BusinessWorks™ Bindings and Palettes Reference.

o Note: If you had already installed third party JDBC drivers in the previous
version of ActiveMatrix BusinessWorks 6.3.x/6.4.x, the drivers do not need
to be re-installed.

5. Install EMS client libraries to use activities from the JMS palette, or the BWAgent
with a database and TIBCO Enterprise Message Service (EMS) for persistence and
transport. For instructions about how to configure the EMS client libraries, see
Integrating with TIBCO Enterprise Message Service™.

6. Install FTL client libraries to use the activities from the FTL palette, or if the BWAgent
is configured to use the dbftl mode. For instructions about how to configure the FTL
client libraries, see Integrating with TIBCO FTL.

7. Optional. If you are using a file based or an LDAP authentication, see "Securing the
bwagent REST API " section in TIBCO ActiveMatrix BusinessWorks™ Administration.

8. Start the BWAgent.

9. Restore the domains.

By default, the runtime components are installed under the TIBCO_HOME /bw/<new_
version> directory and the runtime artifacts such as domains, AppSpaces, and
AppNodes are created under the TIBCO_HOME /bw/<new_version>/domains directory.
If you want to use the runtime artifacts created using the older version of the
software, you can restore the runtime artifacts for the newer version of the software.
Complete the following tasks to restore the runtime artifacts to the new
environment:

Note: You also have the option to re-create the runtime artifacts. For
details on recreating runtime artifacts, see "Administration Tasks and
Reference" section of TIBCO ActiveMatrix BusinessWorks™ Administration.

a. Before restoring the domain, edit the <destination_file>.cmd as described:

e Inthe create -agent command, update the argument domainHome to
provide the TIBCO_HOME /bw/<new_version>/domains directory.

e In the upload -domain command, update the location of the archive file
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to provide the absolute path to the archive file. For example, update the
upload -domain command to the following:

upload -domain BookStore-Domain <7iBCO_HOME>/bw/<old_
version>/bin/archives/BookStore-
Domain/tibco.bw.sample.binding.rest.BookStore.application_1.0.0.ear

Note: You also have the option to import the TIBCO Business Studio
for BusinessWorks projects to a new workspace.

After installing the latest version of the software, use a new TIBCO
Business Studio for BusinessWorks workspace when developing
applications, modules, or rebuilding archive files. To use projects
created in the older version, import the projects to the new
workspace using the File > Import menu in TIBCO Business Studio
for BusinessWorks. Reusing an existing workspace with the newer
version of the software makes that workspace unusable with the
older version of the software.

Note: If the agent name is specified as localhost in the command
file, update it to specify the BWAgent name. The BWAgent name
(bw.agent.memberName) is the specified in the bwagent.ini file.

b. To restore the domain, or other runtime entities, in the new T/BCO_HOME
environment, navigate to the TIBCO_HOME /bw/<new_version>/bin on the
console, and run the following command:

bwadmin -f <destination_file>.cmd

Note: If you encounter issues with the TIBCO ® Enterprise
Administrator web client Ul, stop the TIBCO ° Enterprise
Administrator server, clean up the sr folder under STEA_
ConfigHome/tibco/cfgmgmt/tea/data/sr , and restart the TIBCO °
Enterprise Administrator server.
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What to do next
After you have completed the upgrade, import your projects to a new workspace and

confirm all of your applications are running properly.

Note: Reusing an existing workspace with the newer version of the software
makes that workspace unusable with the older version of the software.

Upgrading from Version 6.4.x/6.5.x to Version
6.6.0

These instructions apply if you are upgrading from version 6.4.2 or later versions of 6.5.x to
version 6.6.0.

Before you begin
» The base version required for this upgrade scenario is 6.4.2 or higher.

e Complete these steps:

1. Back up the domains from the command line, or the Admin UL.

0 Important: Before you back up your domains, ensure that all
runtime artifacts have been stopped, and are not running.

To back up a domain, open a console window and navigate to the TI8C0_
HOME /bw/<older_version>/bin directory. Then run the following command:

bwadmin backup -s <destination_file>.cmd domain <domain_name>

The bwadmin command file <destination_file>.cmd is generated.

If you are restoring to a different location, you need to update the command

file as follows:

°© The BWAgent name points to localhost by default; you need to change
this to the name of the machine you are restoring to.

° Update the domain home to point to the absolute path to the new
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location.

o Update the path to the application archive (EAR) file to an absolute path.

For more information, see "Backing Up and Restoring a Domain" in T/IBCO
ActiveMatrix BusinessWorks™ Administration.

2. Delete domains from the command line, or the Admin Ul.

o Note: Deleting a domain cleans up the database entries. The entries
are repopulated when you restore the domain in the new upgraded
version.

3. Stop the BWAgent.

Procedure
1. Install the software in the same TIBCO_HOME directory.

Follow the instructions in Installation section to install the software in a same TIBCO_
HOME directory using GUI, console, or silent mode.

The installer copies the following files, if they are present, from the T18C0_
HOME /bw/6.x/config/ folder to TIBCO_HOME /bw/6.5/config/ folder and renames the
new files as they are with the _or1ig suffix.

e bwagent_db.json

bwadmin_ftlrealmserver.json

bwagent_ftl.json

jaas.login.conf

realm.properties

krb5.conf

mashery.ini
e logback.xml

2. Optional. If you have made manual updates to configuration files, or .tra files, copy
them from your previous TIBCO_HOME to the appropriate locations in your new
TIBCO_HOME.

3. Update the bwagent.ini file by running the config command with the -cf option.
The command changes based on how the BWAgent is configured for data persistence
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6.

and transport.

If the BWAgent is configured to use an external database and TIBCO FTL for data
persistence and transport, run the following command.

bwadmin config -cf ../config/bwagent_ftl.json agent

If the BWAgent is configured to use an external database and TIBCO Enterprise
Messaging Service, run the following command.

bwadmin config -cf ../config/bwagent_db.json agent

Note: Use bwagent_as/db/ftl.json_orig file if you want to use new
features like Process Monitoring.

Optional. Ensure third party JDBC drivers are installed.

If you want to use other databases, other than PostgreSQL or Microsoft SQL Server,
you must add them separately. This is a one time process for every installation of
ActiveMatrix BusinessWorks. Open the README.txt in the respective database shells
at BW_HOME /config/drivers/shells/ for details on what JAR files to download, and
where to add them.

To add the drivers at run time for Oracle, MySQL or DB2, run the bwinstall
command from <BW_Home>/6.x/bin. Ensure that you run bwinstall with no
arguments to access the help and instructions to add the driver to the run time. For
more information, see "Installing Supported Drivers for Run Time" in TIBCO
ActiveMatrix BusinessWorks™ Bindings and Palettes Reference.

o Note: If you had already installed third party JDBC drivers in the previous
version of ActiveMatrix BusinessWorks 6.3.x/6.4.x, the drivers do not need
to be re-installed.

Install EMS client libraries to use activities from the JMS palette, or the BWAgent
with a database and TIBCO Enterprise Message Service (EMS) for persistence and
transport. For instructions about how to configure the EMS client libraries, see
Integrating with TIBCO Enterprise Message Service™.

Install FTL client libraries to use the activities from the FTL palette, or if the BWAgent
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is configured to use the dbft1l mode. For instructions about how to configure the FTL
client libraries, see Integrating with TIBCO FTL.

7. Optional. If you are using a file based or an LDAP authentication, see "Securing the
bwagent REST API " section in the TIBCO ActiveMatrix BusinessWorks™ Administration.

8. Start the BWAgent.

9. Restore the domains.

By default, the runtime components are installed under the T18CO_HOME /bw/<new_
version> directory and the runtime artifacts such as domains, AppSpaces, and
AppNodes are created under the TIBCO_HOME /bw/<new_version>/domains directory.
If you want to use the runtime artifacts created using the older version of the
software, you can restore the runtime artifacts for the newer version of the software.
Complete the following tasks to restore the runtime artifacts to the new
environment:

o Note: You also have the option to re-create the runtime artifacts. For
details on recreating runtime artifacts, see "Administration Tasks and
Reference" section of the TIBCO ActiveMatrix BusinessWorks™
Administration.

a. Before restoring the domain, edit the <destination_file>.cmd as described:

e Inthe create -agent command, update the argument domainHome to
provide the TIBCO_HOME /bw/<new_version>/domains directory.

e In the upload -domain command, update the location of the archive file
to provide the absolute path to the archive file. For example, update the
upload -domain command to the following:

upload -domain BookStore-Domain <7miBco_HOME>/bw/<old_
version>/bin/archives/BookStore-
Domain/tibco.bw.sample.binding.rest.BookStore.application_1.0.0.ear
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o Note: You also have the option to import the TIBCO Business Studio
for BusinessWorks projects to a new workspace.

After installing the latest version of the software, use a new TIBCO
Business Studio for BusinessWorks workspace when developing
applications, modules, or rebuilding archive files. To use projects
created in the older version, import the projects to the new
workspace using the File > Import... menu in TIBCO Business Studio
for BusinessWorks. Reusing an existing workspace with the newer
version of the software makes that workspace unusable with the
older version of the software.

o Note: If the agent name is specified as localhost in the command
file, update it to specify the BWAgent name. The BWAgent name
(bw.agent.memberName) is the specified in the bwagent.ini file.

b. To restore the domain, or other runtime entities, in the new TIBCO_HOME
environment, navigate to the TIBCO_HOME /bw/<new_version>/bin on the
console, and run the following command:

bwadmin -f <destination_file>.cmd

o Note: If you encounter issues with the TIBCO ® Enterprise
Administrator web client Ul, stop the TIBCO ° Enterprise
Administrator server, clean up the sr folder under STEA_
ConfigHome/tibco/cfgmgmt/tea/data/sr , and restart the TIBCO °
Enterprise Administrator server.

What to do next

After you have completed the upgrade, import your projects to a new workspace and
confirm all of your applications are running properly.

Note: Reusing an existing workspace with the newer version of the software
makes that workspace unusable with the older version of the software. User
history of the executed command is unavailable in the command history table.
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Upgrading from Version 6.4.x/6.5.x/6.6.0 to
Version 6.6.1

These instructions apply if you are upgrading from version 6.4.2 or later versions of
6.4.x/6.5.x/6.6.0 to version 6.6.1.

Before you begin
* The base version required for this upgrade scenario is 6.4.2 or higher.

e Complete these steps:

1. Back up the domains from the command line, or the Admin UL.

0 Important: Before you back up your domains, ensure that all
runtime artifacts have been stopped, and are not running.

To back up a domain, open a console window and navigate to the TIBCO_
HOME /bw/<older_version>/bin directory. Then run the following command:

bwadmin backup -s <destination_file>.cmd domain <domain_name>

The bwadmin command file <destination_file>.cmd is generated.

If you are restoring to a different location, you need to update the command
file as follows:

°© The BWAgent name points to localhost by default; you need to change
this to the name of the machine you are restoring to.

° Update the domain home to point to the absolute path to the new
location.

o Update the path to the application archive (EAR) file to an absolute path.

For more information, see "Backing Up and Restoring a Domain" in T/IBCO
ActiveMatrix BusinessWorks™ Administration.

2. Delete domains from the command line, or the Admin Ul.
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3.

Procedure

o Note: Deleting a domain cleans up the database entries. The entries
are repopulated when you restore the domain in the new upgraded
version.

Stop the BWAgent.

1. Install the software in the same TIBCO_HOME directory.

Follow the instructions in Installation section to install the software in a same TIBCO_
HOME directory using GUI, console, or silent mode.

The installer copies the following files, if they are present, from the T18C0_
HOME /bw/6.x/config/ folder to TIBCO_HOME /bw/6.6/config/ folder and renames the
new files as they are with the _orig suffix.

bwagent_db.json
bwadmin_ftlrealmserver.json
bwagent_ftl.json
jaas.login.conf
realm.properties

krb5.conf

mashery.ini

logback.xml

2. Optional. If you use FTL 5.x in FT mode, add the following properties manually:

File Name Changes Required

bwagent_ftl.json « ftlsecondary: true

 statsftlsecondary:
true

bwagent_db.json ¢ statsftlsecondary:

true
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To create an application on FTL side, use the bwadmin_ftlrealmserver.json_orig
file.

3. Optional. If you have made manual updates to configuration files, or .tra files, copy
them from your previous TIBCO_HOME to the appropriate locations in your new
TIBCO_HOME.

4. Update the bwagent.ini file by running the config command with the -cf option.
The command changes based on how the BWAgent is configured for data persistence
and transport.

If the BWAgent is configured to use an external database and TIBCO FTL for data
persistence and transport, run the following command.

bwadmin config -cf ../config/bwagent_ftl.json agent

If the BWAgent is configured to use an external database and TIBCO Enterprise
Messaging Service, run the following command.

bwadmin config -cf ../config/bwagent_db.json agent

Note: Use bwagent_db/ftl.json_orig file if you want to use new features
like Process Monitoring.

5. Optional. Ensure third party JDBC drivers are installed.

If you want to use other databases, other than PostgreSQL or Microsoft SQL Server,
you must add them separately. This is a one time process for every installation of
ActiveMatrix BusinessWorks. Open the README.txt in the respective database shells
at BW_HOME /config/drivers/shells/ for details on what JAR files to download, and
where to add them.

To add the drivers at run time for Oracle, MySQL or DB2, run the bwinstall
command from <BW_Home>/6.x/bin. Ensure that you run bwinstall with no
arguments to access the help and instructions to add the driver to the run time. For
more information, see "Installing Supported Drivers for Run Time" in TIBCO
ActiveMatrix BusinessWorks™ Bindings and Palettes Reference.
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10.

o Note: If you had already installed third party JDBC drivers in the previous
version of ActiveMatrix BusinessWorks 6.3.x/6.4.x, the drivers do not need
to be re-installed.

Install EMS client libraries to use activities from the JMS palette, or the BWAgent
with a database and TIBCO Enterprise Message Service (EMS) for persistence and
transport. For instructions about how to configure the EMS client libraries, see
Integrating with TIBCO Enterprise Message Service™.

. Install FTL client libraries to use the activities from the FTL palette, or if the BWAgent

is configured to use the dbftl mode. For instructions about how to configure the FTL
client libraries, see Integrating with TIBCO FTL.

Optional. If you are using a file based or an LDAP authentication, see "Securing the
bwagent REST API " section in TIBCO ActiveMatrix BusinessWorks™ Administration.

Start the BWAgent.

Restore the domains.

By default, the runtime components are installed under the T18C0_HOME /bw/<new_
version> directory and the runtime artifacts such as domains, AppSpaces, and
AppNodes are created under the TIBCO_HOME /bw/<new_version>/domains directory.
If you want to use the runtime artifacts created using the older version of the
software, you can restore the runtime artifacts for the newer version of the software.
Complete the following tasks to restore the runtime artifacts to the new
environment:

Note: You also have the option to re-create the runtime artifacts. For
details on recreating runtime artifacts, see "Administration Tasks and
Reference" section in TIBCO ActiveMatrix BusinessWorks™ Administration.

a. Before restoring the domain, edit the <destination_file>.cmd as described:

e Inthe create -agent command, update the argument domainHome to
provide the TIBCO_HOME /bw/<new_version>/domains directory.

e In the upload -domain command, update the location of the archive file
to provide the absolute path to the archive file. For example, update the
upload -domain command to the following:
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upload -domain BookStore-Domain <7iBcO_HOME>/bw/<old_
version>/bin/archives/BookStore-
Domain/tibco.bw.sample.binding.rest.BookStore.application_1.0.0.ear

o Note: You also have the option to import the TIBCO Business Studio
for BusinessWorks projects to a new workspace.

After installing the latest version of the software, use a new TIBCO
Business Studio for BusinessWorks workspace when developing
applications, modules, or rebuilding archive files. To use projects
created in the older version, import the projects to the new
workspace using the File > Import menu in TIBCO Business Studio
for BusinessWorks. Reusing an existing workspace with the newer
version of the software makes that workspace unusable with the
older version of the software.

o Note: If the agent name is specified as localhost in the command
file, update it to specify the BWAgent name. The BWAgent name
(bw.agent.memberName) is the specified in the bwagent.ini file.

b. To restore the domain, or other runtime entities, in the new TIBCO_HOME
environment, navigate to the TIBCO_HOME /bw/<new_version>/bin on the
console, and run the following command:

bwadmin -f <destination_file>.cmd

o Note: If you encounter issues with the TIBCO ® Enterprise
Administrator web client Ul, stop the TIBCO ° Enterprise
Administrator server, clean up the sr folder under STEA_
ConfigHome/tibco/cfgmgmt/tea/data/sr , and restart the TIBCO °
Enterprise Administrator server.

What to do next
After you have completed the upgrade, import your projects to a new workspace and
confirm all of your applications are running properly.
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Note: Reusing an existing workspace with the newer version of the software
makes that workspace unusable with the older version of the software. User
history of the executed command is unavailable in the command history table.

Upgrading from Version 6.4.x/6.5.x/6.6.x to
Version 6.7.0

These instructions apply if you are upgrading from version 6.4.2 or later versions of
6.4.X/6.5.x/6.6.x to version 6.7.0.

Before you begin
» The base version required for this upgrade scenario is 6.4.2 or higher.

e Complete these steps:

1. Back up the domains from the command line, or the Admin Ul.

o Important: Before you back up your domains, ensure that all
runtime artifacts have been stopped, and are not running.

To back up a domain, open a console window and navigate to the TIBC0_
HOME /bw/<older_version>/bin directory. Then run the following command:

bwadmin backup -s <destination_file>.cmd domain <domain_name>

The bwadmin command file <destination_file>.cmd is generated.

If you are restoring to a different location, you need to update the command
file as follows:

° The BWAgent name points to localhost by default; you need to change
this to the name of the machine you are restoring to.

° Update the domain home to point to the absolute path to the new
location.

o Update the path to the application archive (EAR) file to an absolute path.

For more information, see "Backing Up and Restoring a Domain" in T/IBCO
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ActiveMatrix BusinessWorks™ Administration.

2. Delete domains from the command line, or the Admin Ul.

o Note: Deleting a domain cleans up the database entries. The entries
are repopulated when you restore the domain in the new upgraded
version.

3. Stop the BWAgent.

° Tip: While migrating an application from TIBCO ActiveMatrix BusinessWorks™
6.4.2 to 6.7.0, if you deploy the TIBCO ActiveMatrix BusinessWorks™ 6.4.2 EAR as
it is on TIBCO ActiveMatrix BusinessWorks™ 6.7.0 with nil or optional-nil
elements and no input specified and mapped to optional element, the empty
tags are generated at runtime. So, if the output shows empty tags, first rebuild
the EAR file and then deploy the TIBCO ActiveMatrix BusinessWorks™ 6.4.2 EAR
on 6.7.0.

Procedure
1. Install the software in the same TIBCO_HOME directory.

Follow the instructions in Installation section to install the software in a same TIBCO_
HOME directory using GUI, console, or silent mode.

The installer copies the following files, if they are present, from the T18C0_
HOME /bw/6.x/config/ folder to TIBCO_HOME /bw/6.7/config/ folder and renames the
new files as they are with the _orig suffix.

e bwagent_db.json

e bwadmin_ftlrealmserver.json
» bwagent_ftl.json

* jaas.login.conf

e realm.properties

e krb5.conf

e mashery.ini
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e logback.xml

2. Optional. If you use FTL 5.x in FT mode, add the following properties manually:

File Name Changes Required

bwagent_ftl.json « ftlsecondary: true
 statsftlsecondary:

true

bwagent_db.json « statsftlsecondary:
true

To create an application on FTL side, use the bwadmin_ftlrealmserver.json_orig
file.

3. Optional. If you have made manual updates to configuration files, or .tra files, copy
them from your previous TIBCO_HOME to the appropriate locations in your new
TIBCO_HOME.

4. Update the bwagent.ini file by running the config command with the -cf option.
The command changes based on how the BWAgent is configured for data persistence
and transport.

If the BWAgent is configured to use an external database and TIBCO FTL for data
persistence and transport, run the following command.

bwadmin config -cf ../config/bwagent_ftl.json agent

If the BWAgent is configured to use an external database and TIBCO Enterprise
Messaging Service, run the following command.

bwadmin config -cf ../config/bwagent_db.json agent

Note: Use bwagent_db/ftl.json_orig file if you want to use new features
like Process Monitoring.

5. Optional. Ensure third party JDBC drivers are installed.
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10.

If you want to use other databases, other than PostgreSQL or Microsoft SQL Server,
you must add them separately. This is a one time process for every installation of
ActiveMatrix BusinessWorks. Open the README.txt in the respective database shells
at BW_HOME /config/drivers/shells/ for details on what JAR files to download, and
where to add them.

To add the drivers at run time for Oracle, MySQL, MariaDB, or DB2, run the
bwinstall command from <BW_Home>/6.x/bin. Ensure that you run bwinstall with
no arguments to access the help and instructions to add the driver to the run time.
For more information, see "Installing Supported Drivers for Run Time" in TIBCO
ActiveMatrix BusinessWorks™ Bindings and Palettes Reference.

Note: If you had already installed third party JDBC drivers in the previous
version of ActiveMatrix BusinessWorks 6.4.x/6.5.x/6.6.x, do not re-install the
drivers.

Install EMS client libraries to use activities from the JMS palette, or the BWAgent
with a database and TIBCO Enterprise Message Service (EMS) for persistence and
transport. For instructions about how to configure the EMS client libraries, see
Integrating with TIBCO Enterprise Message Service™.

Install FTL client libraries to use the activities from the FTL palette, or if the BWAgent
is configured to use the dbft1l mode. For instructions about how to configure the FTL
client libraries, see Integrating with TIBCO FTL.

Optional. If you are using a file based or an LDAP authentication, see "Securing the
bwagent REST API " section in TIBCO ActiveMatrix BusinessWorks™ Administration.

Start the BWAgent.

Restore the domains.

By default, the runtime components are installed under the TIBCO_HOME /bw/<new_
version> directory and the runtime artifacts such as domains, AppSpaces, and
AppNodes are created under the TIBCO_HOME /bw/<new_version>/domains directory.
If you want to use the runtime artifacts created using the older version of the
software, you can restore the runtime artifacts for the newer version of the software.
Complete the following tasks to restore the runtime artifacts to the new
environment:

TIBCO ActiveMatrix BusinessWorks™ Installation



53 | Upgrading

Note: You also have the option to re-create the runtime artifacts. For
details on recreating runtime artifacts, see "Administration Tasks and
Reference" section in TIBCO ActiveMatrix BusinessWorks™ Administration.

a. Before restoring the domain, edit the <destination_file>.cmd as described:

e In the create -agent command, update the argument domainHome to
provide the TIBCO_HOME /bw/<new_version>/domains directory.

e In the upload -domain command, update the location of the archive file
to provide the absolute path to the archive file. For example, update the
upload -domain command to the following:

upload -domain BookStore-Domain <7BcO_HOME>/bw/<old_
version>/bin/archives/BookStore-
Domain/tibco.bw.sample.binding.rest.BookStore.application_1.0.0.ear

Note: You also have the option to import the TIBCO Business Studio
for BusinessWorks projects to a new workspace.

After installing the latest version of the software, use a new TIBCO
Business Studio for BusinessWorks workspace when developing
applications, modules, or rebuilding archive files. To use projects
created in the older version, import the projects to the new
workspace using the File > Import menu in TIBCO Business Studio
for BusinessWorks. Reusing an existing workspace with the newer
version of the software makes that workspace unusable with the
older version of the software.

Note: If the agent name is specified as localhost in the command
file, update it to specify the BWAgent name. The BWAgent name
(bw.agent.memberName) is the specified in the bwagent.ini file.

b. To restore the domain, or other runtime entities, in the new TIBCO_HOME
environment, navigate to the TIBCO_HOME /bw/<new_version>/bin on the
console, and run the following command:
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bwadmin -f <destination_file>.cmd

o Note: If you encounter issues with the TIBCO ® Enterprise
Administrator web client Ul, stop the TIBCO ° Enterprise
Administrator server, clean up the sr folder under STEA_
ConfigHome/tibco/cfgmgmt/tea/data/sr , and restart the TIBCO °
Enterprise Administrator server.

What to do next
After you have completed the upgrade, import your projects to a new workspace and

confirm all of your applications are running properly.

Note: Reusing an existing workspace with the newer version of the software
makes that workspace unusable with the older version of the software. User
history of the executed command is unavailable in the command history table.

Using MySQL 8.x Database

Procedure
1. Use the following command and then follow the instructions to install the new

MySQL 8.x driver:

bwinstall mysql-driver

2. Update the following properties in the bwagent_ft1l.json or bwagent_db.json files
with the MySQL 8.x database details

Property Name Value

jdbc:mysql://<host or IP address>:<port>/<database_
name>?useSSL=false

dbconnectionurl
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Property Name Value

dbproviderconnectionurl jdbc:mysql://<host or IP address>:<port>/<database_
name>?useSSL=false

For more information about configuring BWAgent with MySQL 8.x, see "Configuring
bwagent for MySQL and TIBCO FTL" or "Configuring bwagent for MySQL and TIBCO
Enterprise Message Service" sections in TIBCO ActiveMatrix BusinessWorks™
Administration.

Upgrading from Version 6.4.x/6.5.x/6.6.x/6.7.x
to Version 6.8.x

For design-time upgrade, if you want to install ActiveMatrix BusinessWorks 6.8.x in existing
TIBCO_HOME with versions 6.4.x/6.5.x/6.6.x, then first install TIBCO AMBW 6.7.0 in the same
TIBCO_HOME and then upgrade to ActiveMatrix BusinessWorks 6.8.x.

For design-time upgrade, if you have ActiveMatrix BusinessWorks 6.7.0 in the TIBCO_HOME,
then you can directly upgrade to ActiveMatrix BusinessWorks 6.8.x.

Note: Re-installation of all the ActiveMatrix BusinessWorks supported plug-ins is
required after upgrading to the version 6.8.x.

For runtime upgrade, you can directly upgrade from ActiveMatrix BusinessWorks
6.5.x/6.6.x/6.7.x to Version AMBW 6.8.x.

TIBCO ActiveMatrix BusinessWorks™ 6.4.2 is compatible with FTL 5.4.2.

The following instructions apply for the other components such as Administration and Core
Runtime if you are upgrading from version 6.4.2 or later versions of 6.4.x/6.5.x/6.6.x/6.7.x to
version 6.8.x.

Before you begin

* The base version required for this upgrade scenario is 6.4.2 or higher.

e Complete these steps:
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1. Back up the domains from the command line, or the Admin Ul.

o Important: Before you back up your domains, ensure that all
runtime artifacts have been stopped, and are not running.

To back up a domain, open a console window and navigate to the TIBCO_
HOME /bw/<older_version>/bin directory. Then run the following command:

bwadmin backup -s <destination_file>.cmd domain <domain_name>

The bwadmin command file <destination_file>.cmd is generated.

If you are restoring to a different location, you need to update the command
file as follows:

° The BWAgent name points to localhost by default; you need to change
this to the name of the machine you are restoring to.

° Update the domain home to point to the absolute path to the new
location.

o Update the path to the application archive (EAR) file to an absolute path.

For more information, see "Backing Up and Restoring a Domain" in T/IBCO
ActiveMatrix BusinessWorks™ Administration.

2. Delete domains from the command line, or the Admin UlI.

o Note: Deleting a domain cleans up the database entries. The entries
are repopulated when you restore the domain in the new upgraded
version.

3. Stop the BWAgent.

Procedure
1. Install the software in the same TIBCO_HOME directory.

Follow the instructions in Installation section to install the software in a same TIBCO_
HOME directory using GUI, console, or silent mode.

The installer copies the following files, if they are present, from the T18c0_
HOME /bw/6.x/config/ folder to TIBCO_HOME /bw/6.8/config/ folder and renames the
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new files as they are with the _orig suffix.
e bwagent_db.json
e bwadmin_ftlrealmserver.json
» bwagent_ftl.json
* jaas.login.conf
e realm.properties
e krb5.conf
e mashery.ini
e logback.xml

2. Optional. If you use FTL 5.x in FT mode, add the following properties manually:

File Name Changes Required

bwagent_ftl.json « ftlsecondary: true

 statsftlsecondary:
true

bwagent_db.json « statsftlsecondary:
true

To create an application on FTL side, use the bwadmin_ftlrealmserver.json_orig
file.

3. Optional. If you have made manual updates to configuration files, or .tra files, copy
them from your previous TIBCO_HOME to the appropriate locations in your new
TIBCO_HOME.

4. Update the bwagent.ini file by running the config command with the -cf option.
The command changes based on how the BWAgent is configured for data persistence
and transport.

If the BWAgent is configured to use an external database and TIBCO FTL for data
persistence and transport, run the following command.
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bwadmin config -cf ../config/bwagent_ftl.json agent

If the BWAgent is configured to use an external database and TIBCO Enterprise
Messaging Service, run the following command.

bwadmin config -cf ../config/bwagent_db.json agent

Note: Use bwagent_db/ftl.json_orig file if you want to use new features
like Process Monitoring.

5. Optional. Ensure third party JDBC drivers are installed.

If you want to use other databases, other than PostgreSQL or Microsoft SQL Server,
you must add them separately. This is a one time process for every installation of
ActiveMatrix BusinessWorks. Open the README.txt in the respective database shells
at BW_HOME /config/drivers/shells/ for details on what JAR files to download, and
where to add them.

To add the drivers at run time for Oracle, MySQL, MariaDB, or DB2, run the
bwinstall command from <BW_Home>/6.x/bin. Ensure that you run bwinstall with
no arguments to access the help and instructions to add the driver to the run time.
For more information, see "Installing Supported Drivers for Run Time" in TIBCO
ActiveMatrix BusinessWorks™ Bindings and Palettes Reference.

Note: If you had already installed third party JDBC drivers in the previous
version of ActiveMatrix BusinessWorks 6.4.x/6.5.x/6.6.x, do not re-install the
drivers.

6. Install EMS client libraries to use activities from the JMS palette, or the BWAgent
with a database and TIBCO Enterprise Message Service (EMS) for persistence and
transport. For instructions about how to configure the EMS client libraries, see
Integrating with TIBCO Enterprise Message Service™.

7. Install FTL client libraries to use the activities from the FTL palette, or if the BWAgent
is configured to use the dbftl mode. For instructions about how to configure the FTL
client libraries, see Integrating with TIBCO FTL.

8. Optional. If you are using a file based or an LDAP authentication, see "Securing the
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bwagent REST API " section in TIBCO ActiveMatrix BusinessWorks™ Administration.
9. Start the BWAgent.

10. Restore the domains.

By default, the runtime components are installed under the TI1BCO_HOME /bw/<new_
version> directory and the runtime artifacts such as domains, AppSpaces, and
AppNodes are created under the TIBCO_HOME /bw/<new_version>/domains directory.
If you want to use the runtime artifacts created using the older version of the
software, you can restore the runtime artifacts for the newer version of the software.
Complete the following tasks to restore the runtime artifacts to the new
environment:

Note: You also have the option to re-create the runtime artifacts. For
details on recreating runtime artifacts, see "Administration Tasks and
Reference" section in TIBCO ActiveMatrix BusinessWorks™ Administration.

a. Before restoring the domain, edit the <destination_file>.cmd as described:

e In the create -agent command, update the argument domainHome to
provide the TIBCO_HOME /bw/<new_version>/domains directory.

e In the upload -domain command, update the location of the archive file
to provide the absolute path to the archive file. For example, update the
upload -domain command to the following:

upload -domain BookStore-Domain <7Bco_HOME>/bw/<old_
version>/bin/archives/BookStore-
Domain/tibco.bw.sample.binding.rest.BookStore.application_1.0.0.ear
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o Note: You also have the option to import the TIBCO Business Studio
for BusinessWorks projects to a new workspace.

After installing the latest version of the software, use a new TIBCO
Business Studio for BusinessWorks workspace when developing
applications, modules, or rebuilding archive files. To use projects
created in the older version, import the projects to the new
workspace using the File > Import menu in TIBCO Business Studio
for BusinessWorks. Reusing an existing workspace with the newer
version of the software makes that workspace unusable with the
older version of the software.

o Note: If the agent name is specified as localhost in the command
file, update it to specify the BWAgent name. The BWAgent name
(bw.agent.memberName) is the specified in the bwagent.ini file.

b. To restore the domain, or other runtime entities, in the new TIBCO_HOME
environment, navigate to the TIBCO_HOME /bw/<new_version>/bin on the
console, and run the following command:

bwadmin -f <destination_file>.cmd

o Note: If you encounter issues with the TIBCO ® Enterprise
Administrator web client Ul, stop the TIBCO ° Enterprise
Administrator server, clean up the sr folder under STEA_
ConfigHome/tibco/cfgmgmt/tea/data/sr , and restart the TIBCO °
Enterprise Administrator server.

What to do next

After you have completed the upgrade, import your projects to a new workspace and
confirm all of your applications are running properly.

Note: Reusing an existing workspace with the newer version of the software
makes that workspace unusable with the older version of the software. User
history of the executed command is unavailable in the command history table.
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Following are the steps for post upgrade to Debug/Run applications for users who are
working on an existing workspace:

Procedure
1. In a previously created workspace, right click on an application and select the
Debug/Run Configuration option.

2. In the Debug/Run Configuration window, right click on BusinessWorks Application
option and select New Configuration.
A new configuration is created. For example, 'BWApplication(1)',(2),....

3. In the New Configuration, click Debug/Run.

Upgrading from Version
6.4.X/6.5.x/6.6.x/6.7.x/6.8.0 to Version 6.8.1

For design-time upgrade, if you want to install ActiveMatrix BusinessWorks 6.8.1 in existing
TIBCO_HOME with versions 6.4.x/6.5.x/6.6.x, then first install TIBCO AMBW 6.7.0 in the same
TIBCO_HOME and then upgrade to ActiveMatrix BusinessWorks 6.8.1.

For design-time upgrade, if you have ActiveMatrix BusinessWorks 6.7.0 in the TIBCO_HOME,
then you can directly upgrade to ActiveMatrix BusinessWorks 6.8.1.

Note: Re-installation of all the ActiveMatrix BusinessWorks supported plug-ins is
required after upgrading to the version 6.8.1, if you are upgrading from
ActiveMatrix BusinessWorks 6.7.0.

For runtime upgrade, you can directly upgrade from ActiveMatrix BusinessWorks
6.5.x/6.6.x/6.7.x/6.8.0 to version AMBW 6.8.1.

TIBCO ActiveMatrix BusinessWorks™ 6.4.2 is compatible with FTL 5.4.2.

The following instructions apply for the other components such as Administration and Core
Runtime if you are upgrading from version 6.4.2 or later versions of
6.4.X/6.5.x/6.6.x/6.7.x/6.8.0 to version 6.8.1.
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Before you begin
* The base version required for this upgrade scenario is 6.4.2 or higher.

e Complete these steps:

1. Back up the domains from the command line, or the Admin UL.

0 Important: Before you back up your domains, ensure that all
runtime artifacts have been stopped, and are not running.

To back up a domain, open a console window and navigate to the TIBCO_
HOME /bw/<older_version>/bin directory. Then run the following command:

bwadmin backup -s <destination_file>.cmd domain <domain_name>

The bwadmin command file <destination_file>.cmd is generated.

If you are restoring to a different location, you need to update the command
file as follows:

°© The BWAgent name points to localhost by default; you need to change
this to the name of the machine you are restoring to.

° Update the domain home to point to the absolute path to the new
location.

o Update the path to the application archive (EAR) file to an absolute path.

For more information, see "Backing Up and Restoring a Domain" in T/IBCO
ActiveMatrix BusinessWorks™ Administration.

2. Delete domains from the command line, or the Admin Ul.

o Note: Deleting a domain cleans up the database entries. The entries
are repopulated when you restore the domain in the new upgraded
version.

3. Stop the BWAgent.
Procedure

1. Install the software in the same TIBCO_HOME directory.

Follow the instructions in Installation section to install the software in a same TIBCO_
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HOME directory using GUI, console, or silent mode.

The installer copies the following files, if they are present, from the T18C0_
HOME /bw/6.x/config/ folder to TIBCO_HOME /bw/6.8/config/ folder and renames the
new files as they are with the _orig suffix.

e bwagent_db.json

e bwadmin_ftlrealmserver.json
e bwagent_ftl.json
 jaas.login.conf

e realm.properties

e krb5.conf

e mashery.ini

e logback.xml

2. Optional. If you use FTL 5.x in FT mode, add the following properties manually:

File Name Changes Required

bwagent_ftl.json * ftlsecondary: true

¢ statsftlsecondary:
true

bwagent_db.json  statsftlsecondary:
true

To create an application on FTL side, use the bwadmin_ftlrealmserver.json_orig
file.

3. Optional. If you have made manual updates to configuration files, or .tra files, copy
them from your previous TIBCO_HOME to the appropriate locations in your new
TIBCO_HOME.

4. Update the bwagent.ini file by running the config command with the -cf option.
The command changes based on how the BWAgent is configured for data persistence
and transport.
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If the BWAgent is configured to use an external database and TIBCO FTL for data
persistence and transport, run the following command.

bwadmin config -cf ../config/bwagent_ftl.json agent

If the BWAgent is configured to use an external database and TIBCO Enterprise
Messaging Service, run the following command.

bwadmin config -cf ../config/bwagent_db.json agent

Note: Use bwagent_db/ftl.json_orig file if you want to use new features
like Process Monitoring.

5. Optional. Ensure third party JDBC drivers are installed.

If you want to use other databases, other than PostgreSQL or Microsoft SQL Server,
you must add them separately. This is a one time process for every installation of
ActiveMatrix BusinessWorks. Open the README.txt in the respective database shells
at BW_HOME /config/drivers/shells/ for details on what JAR files to download, and
where to add them.

To add the drivers at run time for Oracle, MySQL, MariaDB, or DB2, run the
bwinstall command from <BW_Home>/6.x/bin. Ensure that you run bwinstall with
no arguments to access the help and instructions to add the driver to the run time.
For more information, see "Installing Supported Drivers for Run Time" in TIBCO
ActiveMatrix BusinessWorks™ Bindings and Palettes Reference.

o Note: If you had already installed third party JDBC drivers in the previous
version of ActiveMatrix BusinessWorks 6.4.x/6.5.x/6.6.x/6.7.x/6.8.0 do not
re-install the drivers.

6. Install EMS client libraries to use activities from the JMS palette, or the BWAgent
with a database and TIBCO Enterprise Message Service (EMS) for persistence and
transport. For instructions about how to configure the EMS client libraries, see
Integrating with TIBCO Enterprise Message Service™.

7. Install FTL client libraries to use the activities from the FTL palette, or if the BWAgent
is configured to use the dbftl mode. For instructions about how to configure the FTL
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client libraries, see Integrating with TIBCO FTL.

8. Optional. If you are using a file based or an LDAP authentication, see "Securing the
bwagent REST API " section in TIBCO ActiveMatrix BusinessWorks™ Administration.

9. Start the BWAgent.

10. Restore the domains.

By default, the runtime components are installed under the T18CO_HOME /bw/<new_
version> directory and the runtime artifacts such as domains, AppSpaces, and
AppNodes are created under the TIBCO_HOME /bw/<new_version>/domains directory.
If you want to use the runtime artifacts created using the older version of the
software, you can restore the runtime artifacts for the newer version of the software.
Complete the following tasks to restore the runtime artifacts to the new
environment:

Note: You also have the option to re-create the runtime artifacts. For
details on recreating runtime artifacts, see "Administration Tasks and
Reference" section in TIBCO ActiveMatrix BusinessWorks™ Administration.

a. Before restoring the domain, edit the <destination_file>.cmd as described:

e Inthe create -agent command, update the argument domainHome to
provide the TIBCO_HOME /bw/<new_version>/domains directory.

e In the upload -domain command, update the location of the archive file
to provide the absolute path to the archive file. For example, update the
upload -domain command to the following:

upload -domain BookStore-Domain <7iBcO_HOME>/bw/<old_
version>/bin/archives/BookStore-
Domain/tibco.bw.sample.binding.rest.BookStore.application_1.0.0.ear
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o Note: You also have the option to import the TIBCO Business Studio
for BusinessWorks projects to a new workspace.

After installing the latest version of the software, use a new TIBCO
Business Studio for BusinessWorks workspace when developing
applications, modules, or rebuilding archive files. To use projects
created in the older version, import the projects to the new
workspace using the File > Import menu in TIBCO Business Studio
for BusinessWorks. Reusing an existing workspace with the newer
version of the software makes that workspace unusable with the
older version of the software.

o Note: If the agent name is specified as localhost in the command
file, update it to specify the BWAgent name. The BWAgent name
(bw.agent.memberName) is the specified in the bwagent.ini file.

b. To restore the domain, or other runtime entities, in the new TIBCO_HOME
environment, navigate to the TIBCO_HOME /bw/<new_version>/bin on the
console, and run the following command:

bwadmin -f <destination_file>.cmd

o Note: If you encounter issues with the TIBCO ® Enterprise
Administrator web client Ul, stop the TIBCO ° Enterprise
Administrator server, clean up the sr folder under STEA_
ConfigHome/tibco/cfgmgmt/tea/data/sr , and restart the TIBCO °
Enterprise Administrator server.

What to do next

After you have completed the upgrade, import your projects to a new workspace and
confirm all of your applications are running properly.

Note: Reusing an existing workspace with the newer version of the software
makes that workspace unusable with the older version of the software. User
history of the executed command is unavailable in the command history table.
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Following are the steps for post upgrade to Debug/Run applications for users who are
working on an existing workspace:

Procedure
1. In a previously created workspace, right click on an application and select the
Debug/Run Configuration option.

2. In the Debug/Run Configuration window, right click on BusinessWorks Application

option and select New Configuration.
A new configuration is created. For example, 'BWApplication(1)',(2),....

3. In the New Configuration, click Debug/Run.

Upgrading from Version
6.4.x/6.5.x/6.6.x/6.7.x/6.8.x to Version 6.9.0

For design-time upgrade, if you want to install ActiveMatrix BusinessWorks 6.9.0 in existing
TIBCO_HOME with versions 6.4.x/6.5.x/6.6.x, then first install TIBCO AMBW 6.7.0 in the same
TIBCO_HOME and then upgrade to ActiveMatrix BusinessWorks 6.9.0.

For design-time upgrade, if you have ActiveMatrix BusinessWorks 6.7.0 in the TIBCO_HOME,
then you can directly upgrade to ActiveMatrix BusinessWorks 6.9.0.

o Note:

* Re-installation of all the ActiveMatrix BusinessWorks supported plug-ins is
required after upgrading to the version 6.9.0, if you are upgrading from
ActiveMatrix BusinessWorks 6.7.0.

» Post upgrade, it is recommended to append the -clean argument in the
TIBCOBusinessStudio.ini file.

For runtime upgrade, you can directly upgrade from ActiveMatrix BusinessWorks
6.5.X/6.6.x/6.7.X/6.8.x to version AMBW 6.9.0.

The following instructions apply for the other components such as Administration and Core
Runtime if you are upgrading from version 6.4.2 or later versions of
6.4.X/6.5.x/6.6.x/6.7.x/6.8.x to version 6.9.0.
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Before you begin
* The base version required for this upgrade scenario is 6.4.2 or higher.

e Complete these steps:

1. Back up the domains from the command line, or the Admin UL.

0 Important: Before you back up your domains, ensure that all
runtime artifacts have been stopped, and are not running.

To back up a domain, open a console window and navigate to the TIBC0O_
HOME /bw/<older_version>/bin directory. Then run the following command:

bwadmin backup -s <destination_file>.cmd domain <domain_name>

The bwadmin command file <destination_file>.cmd is generated.

If you are restoring to a different location, you need to update the command
file as follows:

°© The BWAgent name points to localhost by default; you need to change
this to the name of the machine you are restoring to.

° Update the domain home to point to the absolute path to the new
location.

o Update the path to the application archive (EAR) file to an absolute path.

For more information, see "Backing Up and Restoring a Domain" in T/IBCO
ActiveMatrix BusinessWorks™ Administration.

2. Delete domains from the command line, or the Admin Ul.

o Note: Deleting a domain cleans up the database entries. The entries
are repopulated when you restore the domain in the new upgraded
version.

3. Stop the BWAgent.
Procedure

1. Install the software in the same TIBCO_HOME directory.

Follow the instructions in Installation section to install the software in a same TIBCO_
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HOME directory using GUI, console, or silent mode.

The installer copies the following files, if they are present, from the T18C0_
HOME /bw/6.x/config/ folder to TIBCO_HOME /bw/6.8/config/ folder and renames the
new files as they are with the _orig suffix.

e bwagent_db.json

e bwadmin_ftlrealmserver.json
e bwagent_ftl.json
 jaas.login.conf

e realm.properties

e krb5.conf

e mashery.ini

e logback.xml

2. Optional. If you use FTL 5.x in FT mode, add the following properties manually:

File Name Changes Required

bwagent_ftl.json * ftlsecondary: true

¢ statsftlsecondary:
true

bwagent_db.json  statsftlsecondary:
true

To create an application on FTL side, use the bwadmin_ftlrealmserver.json_orig
file.

3. Optional. If you have made manual updates to configuration files, or .tra files, copy
them from your previous TIBCO_HOME to the appropriate locations in your new
TIBCO_HOME.

4. Update the bwagent.ini file by running the config command with the -cf option.
The command changes based on how the BWAgent is configured for data persistence
and transport.
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If the BWAgent is configured to use an external database and TIBCO FTL for data
persistence and transport, run the following command.

bwadmin config -cf ../config/bwagent_ftl.json agent

If the BWAgent is configured to use an external database and TIBCO Enterprise
Messaging Service, run the following command.

bwadmin config -cf ../config/bwagent_db.json agent

Note: Use bwagent_db/ftl.json_orig file if you want to use new features
like Process Monitoring.

5. Optional. Ensure third party JDBC drivers are installed.

If you want to use other databases, other than PostgreSQL or Microsoft SQL Server,
you must add them separately. This is a one time process for every installation of
ActiveMatrix BusinessWorks. Open the README.txt in the respective database shells
at BW_HOME /config/drivers/shells/ for details on what JAR files to download, and
where to add them.

To add the drivers at run time for Oracle, MySQL, MariaDB, or DB2, run the
bwinstall command from <BW_Home>/6.x/bin. Ensure that you run bwinstall with
no arguments to access the help and instructions to add the driver to the run time.
For more information, see "Installing Supported Drivers for Run Time" in TIBCO
ActiveMatrix BusinessWorks™ Bindings and Palettes Reference.

o Note: If you had already installed third party JDBC drivers in the previous
version of ActiveMatrix BusinessWorks 6.4.x/6.5.x/6.6.x/6.7.x/6.8.x, do not
re-install the drivers.

6. Install EMS client libraries to use activities from the JMS palette, or the BWAgent with
a database and TIBCO Enterprise Message Service (EMS) for persistence and
transport. For instructions about how to configure the EMS client libraries, see
Integrating with TIBCO Enterprise Message Service™.

7. Install FTL client libraries to use the activities from the FTL palette, or if the BWAgent
is configured to use the dbftl mode. For instructions about how to configure the FTL
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client libraries, see Integrating with TIBCO FTL.

8. Optional. If you are using a file based or an LDAP authentication, see "Securing the
bwagent REST API " section in TIBCO ActiveMatrix BusinessWorks™ Administration.

9. Start the BWAgent.

10. Restore the domains.

By default, the runtime components are installed under the T18CO_HOME /bw/<new_
version> directory and the runtime artifacts such as domains, AppSpaces, and
AppNodes are created under the TIBCO_HOME /bw/<new_version>/domains directory.
If you want to use the runtime artifacts created using the older version of the
software, you can restore the runtime artifacts for the newer version of the software.
Complete the following tasks to restore the runtime artifacts to the new
environment:

Note: You also have the option to re-create the runtime artifacts. For
details on recreating runtime artifacts, see "Administration Tasks and
Reference" section in TIBCO ActiveMatrix BusinessWorks™ Administration.

a. Before restoring the domain, edit the <destination_file>.cmd as described:

e Inthe create -agent command, update the argument domainHome to
provide the TIBCO_HOME /bw/<new_version>/domains directory.

e In the upload -domain command, update the location of the archive file
to provide the absolute path to the archive file. For example, update the
upload -domain command to the following:

upload -domain BookStore-Domain <7iBcO_HOME>/bw/<old_
version>/bin/archives/BookStore-
Domain/tibco.bw.sample.binding.rest.BookStore.application_1.0.0.ear
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o Note: You also have the option to import the TIBCO Business Studio
for BusinessWorks projects to a new workspace.

After installing the latest version of the software, use a new TIBCO
Business Studio for BusinessWorks workspace when developing
applications, modules, or rebuilding archive files. To use projects
created in the older version, import the projects to the new
workspace using the File > Import menu in TIBCO Business Studio
for BusinessWorks. Reusing an existing workspace with the newer
version of the software makes that workspace unusable with the
older version of the software.

o Note: If the agent name is specified as localhost in the command
file, update it to specify the BWAgent name. The BWAgent name
(bw.agent.memberName) is the specified in the bwagent.ini file.

b. To restore the domain, or other runtime entities, in the new TIBCO_HOME
environment, navigate to the TIBCO_HOME /bw/<new_version>/bin on the
console, and run the following command:

bwadmin -f <destination_file>.cmd

o Note: If you encounter issues with the TIBCO ® Enterprise
Administrator web client Ul, stop the TIBCO ° Enterprise
Administrator server, clean up the sr folder under STEA_
ConfigHome/tibco/cfgmgmt/tea/data/sr , and restart the TIBCO °
Enterprise Administrator server.

What to do next

After you have completed the upgrade, import your projects to a new workspace and
confirm all of your applications are running properly.

Note: Reusing an existing workspace with the newer version of the software
makes that workspace unusable with the older version of the software. User
history of the executed command is unavailable in the command history table.
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Following are the steps for post upgrade to Debug/Run applications for users who are
working on an existing workspace:

Procedure
1. In a previously created workspace, right click on an application and select the

Debug/Run Configuration option.

2. In the Debug/Run Configuration window, right click on BusinessWorks Application

option and select New Configuration.
A new configuration is created. For example, 'BWApplication(1)',(2),....

3. In the New Configuration, click Debug/Run.

Upgrading from Version 6.6.x/6.7.x/6.8.x/6.9.0
to Version 6.9.1

For design-time upgrade, if you want to install ActiveMatrix BusinessWorks 6.9.1 in existing
TIBCO_HOME with versions 6.6.x, then first install TIBCO AMBW 6.7.0 in the same TIBCO_
HOME and then upgrade to ActiveMatrix BusinessWorks 6.9.1.

For design-time upgrade, if you have ActiveMatrix BusinessWorks 6.7.0 in the TIBCO_HOME,
then you can directly upgrade to ActiveMatrix BusinessWorks 6.9.1.

o Note:

* Re-installation of all the ActiveMatrix BusinessWorks supported plug-ins is
required after upgrading to the version 6.9.1, if you are upgrading from
ActiveMatrix BusinessWorks 6.7.0.

» Post upgrade, it is recommended to append the -clean argument in the
TIBCOBusinessStudio.ini file.

For runtime upgrade, you can directly upgrade from ActiveMatrix BusinessWorks
6.6.X/6.7.x/6.8.x/6.9.0 to version AMBW 6.9.1.

The following instructions apply for the other components such as Administration and Core
Runtime if you are upgrading from 6.6.x/6.7.x/6.8.x/6.9.0 to version 6.9.1.
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Before you begin
* The base version required for this upgrade scenario is 6.6.0 or higher.

e Complete these steps:

1. Back up the domains from the command line, or the Admin UL.

0 Important: Before you back up your domains, ensure that all
runtime artifacts have been stopped, and are not running.

To back up a domain, open a console window and navigate to the TIBC0O_
HOME /bw/<older_version>/bin directory. Then run the following command:

bwadmin backup -s <destination_file>.cmd domain <domain_name>

The bwadmin command file <destination_file>.cmd is generated.

If you are restoring to a different location, you need to update the command
file as follows:

°© The BWAgent name points to localhost by default; you need to change
this to the name of the machine you are restoring to.

° Update the domain home to point to the absolute path to the new
location.

o Update the path to the application archive (EAR) file to an absolute path.

For more information, see "Backing Up and Restoring a Domain" in T/IBCO
ActiveMatrix BusinessWorks™ Administration.

2. Delete domains from the command line, or the Admin Ul.

o Note: Deleting a domain cleans up the database entries. The entries
are repopulated when you restore the domain in the new upgraded
version.

3. Stop the BWAgent.
Procedure

1. Install the software in the same TIBCO_HOME directory.

Follow the instructions in Installation section to install the software in a same TIBCO_
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HOME directory using GUI, console, or silent mode.

The installer copies the following files, if they are present, from the T18C0_
HOME /bw/6.x/config/ folder to TIBCO_HOME /bw/6.8/config/ folder and renames the
new files as they are with the _orig suffix.

e bwagent_db.json

e bwadmin_ftlrealmserver.json
e bwagent_ftl.json
 jaas.login.conf

e realm.properties

e krb5.conf

e mashery.ini

e logback.xml

2. Optional. If you use FTL 5.x in FT mode, add the following properties manually:

File Name Changes Required

bwagent_ftl.json * ftlsecondary: true

¢ statsftlsecondary:
true

bwagent_db.json  statsftlsecondary:
true

To create an application on FTL side, use the bwadmin_ftlrealmserver.json_orig
file.

3. Optional. If you have made manual updates to configuration files, or .tra files, copy
them from your previous TIBCO_HOME to the appropriate locations in your new
TIBCO_HOME.

4. Update the bwagent.ini file by running the config command with the -cf option.
The command changes based on how the BWAgent is configured for data persistence
and transport.
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If the BWAgent is configured to use an external database and TIBCO FTL for data
persistence and transport, run the following command.

bwadmin config -cf ../config/bwagent_ftl.json agent

If the BWAgent is configured to use an external database and TIBCO Enterprise
Messaging Service, run the following command.

bwadmin config -cf ../config/bwagent_db.json agent

Note: Use bwagent_db/ftl.json_orig file if you want to use new features
like Process Monitoring.

5. Optional. Ensure third party JDBC drivers are installed.

If you want to use other databases, other than PostgreSQL or Microsoft SQL Server,
you must add them separately. This is a one time process for every installation of
ActiveMatrix BusinessWorks. Open the README.txt in the respective database shells
at BW_HOME /config/drivers/shells/ for details on what JAR files to download, and
where to add them.

To add the drivers at run time for Oracle, MySQL, MariaDB, or DB2, run the
bwinstall command from <BW_Home>/6.x/bin. Ensure that you run bwinstall with
no arguments to access the help and instructions to add the driver to the run time.
For more information, see "Installing Supported Drivers for Run Time" in TIBCO
ActiveMatrix BusinessWorks™ Bindings and Palettes Reference.

o Note: If you had already installed third party JDBC drivers in the previous
version of ActiveMatrix BusinessWorks 6.6.x/6.7.x/6.8.x/6.9.0, do not re-
install the drivers.

6. Install EMS client libraries to use activities from the JMS palette, or the BWAgent with
a database and TIBCO Enterprise Message Service (EMS) for persistence and
transport. For instructions about how to configure the EMS client libraries, see
Integrating with TIBCO Enterprise Message Service™.

7. Install FTL client libraries to use the activities from the FTL palette, or if the BWAgent
is configured to use the dbftl mode. For instructions about how to configure the FTL
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client libraries, see Integrating with TIBCO FTL.

8. Optional. If you are using a file based or an LDAP authentication, see "Securing the
bwagent REST API" section in TIBCO ActiveMatrix BusinessWorks™ Administration.

9. Start the BWAgent.

10. Restore the domains.

By default, the runtime components are installed under the T18CO_HOME /bw/<new_
version> directory and the runtime artifacts such as domains, AppSpaces, and
AppNodes are created under the TIBCO_HOME /bw/<new_version>/domains directory.
If you want to use the runtime artifacts created using the older version of the
software, you can restore the runtime artifacts for the newer version of the software.
Complete the following tasks to restore the runtime artifacts to the new
environment:

Note: You also have the option to re-create the runtime artifacts. For
details on recreating runtime artifacts, see "Administration Tasks and
Reference" section in TIBCO ActiveMatrix BusinessWorks™ Administration.

a. Before restoring the domain, edit the <destination_file>.cmd as described:

e Inthe create -agent command, update the argument domainHome to
provide the TIBCO_HOME /bw/<new_version>/domains directory.

e In the upload -domain command, update the location of the archive file
to provide the absolute path to the archive file. For example, update the
upload -domain command to the following:

upload -domain BookStore-Domain <7iBcO_HOME>/bw/<old_
version>/bin/archives/BookStore-
Domain/tibco.bw.sample.binding.rest.BookStore.application_1.0.0.ear
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o Note: You also have the option to import the TIBCO Business Studio
for BusinessWorks projects to a new workspace.

After installing the latest version of the software, use a new TIBCO
Business Studio for BusinessWorks workspace when developing
applications, modules, or rebuilding archive files. To use projects
created in the older version, import the projects to the new
workspace using the File > Import menu in TIBCO Business Studio
for BusinessWorks. Reusing an existing workspace with the newer
version of the software makes that workspace unusable with the
older version of the software.

o Note: If the agent name is specified as localhost in the command
file, update it to specify the BWAgent name. The BWAgent name
(bw.agent.memberName) is the specified in the bwagent.ini file.

b. To restore the domain, or other runtime entities, in the new TIBCO_HOME
environment, navigate to the TIBCO_HOME /bw/<new_version>/bin on the
console, and run the following command:

bwadmin -f <destination_file>.cmd

o Note: If you encounter issues with the TIBCO ® Enterprise
Administrator web client Ul, stop the TIBCO ° Enterprise
Administrator server, clean up the sr folder under STEA_
ConfigHome/tibco/cfgmgmt/tea/data/sr , and restart the TIBCO °
Enterprise Administrator server.

What to do next

After you have completed the upgrade, import your projects to a new workspace and
confirm all of your applications are running properly.

Note: Reusing an existing workspace with the newer version of the software
makes that workspace unusable with the older version of the software. User
history of the executed command is unavailable in the command history table.
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Following are the steps for post upgrade to Debug/Run applications for users who are
working on an existing workspace:

Procedure
1. In a previously created workspace, right click on an application and select the

Debug/Run Configuration option.

2. In the Debug/Run Configuration window, right click on BusinessWorks Application

option and select New Configuration.
A new configuration is created. For example, 'BWApplication(1)',(2),....

3. In the New Configuration, click Debug/Run.
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Updating the Database Schema to Enable
BWAgent to Use Database with TIBCO
Enterprise Message Service

If you are upgrading from TIBCO ActiveMatrix BusinessWorks™ 6.3.1™, or from TIBCO
ActiveMatrix BusinessWorks™ 6.3.2, to a higher version of the software, refer to the
following sections for instructions on how to update the database schemas for PostgreSQL,
Microsoft SQL, Oracle, DB2, and MySQL.

PostgreSQL, Microsoft SQL, Oracle, or DB2

If you have configured BWAgent to use PostgreSQL, Microsoft SQL, Oracle, or DB2 with
TIBCO Enterprise Message Service (EMS) for persistence and transport, update the database
schema by following these steps:

1. Back-up your data in the commandHistory table.

2. Execute the following command to drop the table.

drop table commandHistory;

3. Restart the BWAgent.

MySQL

If you have configured BWAgent to use MySQL with TIBCO Enterprise Message Service
(EMS) for persistence and transport, update the database schema by following these steps:

1. Execute the following command to alter the table.

ALTER TABLE commandHistory MODIFY commandId int NOT NULL AUTO_
INCREMENT;

2. Restart the BWAgent.
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Installing ActiveMatrix BusinessWorks Plug-
ins

You can install the ActiveMatrix BusinessWorks plug-in in the following ways. For details
about installation procedures, see the Installation guide provided with the respective plug-
in.

Installation method Description
Installation by Using an Update Site

Install from the You can install the plug-in from within TIBCO Business Studio for
public update site BusinessWorks by using the public update site.

Install from a local You can install the plug-in from within TIBCO Business Studio for
update site or BusinessWorks by using a local update site or a shared directory
directory managed by your organization.

Install using You can install the plug-ins from within TIBCO Business Studio for

BusinessWorks Plug-  BusinessWorks using the BusinessWorks Plug-ins Manager.
ins Manager

Installation by Using the TIBCO Universal Installer
Install using the You can install the plug-ins from within the TIBCO Universal Installer

TIBCO Universal package.
Installerpackage

TIBCO ActiveMatrix BusinessWorks™ Installation



82 | Uninstalling ActiveMatrix BusinessWorks Plug-ins

Uninstalling ActiveMatrix BusinessWorks
Plug-ins

You can uninstall plug-ins in the following ways. For details about uninstallation
procedures, see the Installation guide provided with the respective plug-in.

Uninstallation method Description

Uninstallation by Using an Update Site

Uninstall plug-ins that were You can uninstall the plug-in from within TIBCO Business
installed using the public Studio for BusinessWorks by using the public update site.
update site

Uninstall using BusinessWorks  You can uninstall the plug-ins from within TIBCO Business
Plug-ins Manager Studio for BusinessWorks using the BusinessWorks Plug-ins
Manager.
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Uninstalling the Software

TIBCO Universal Installer can be used to uninstall the software. Using the Universal
Installer, you can choose to uninstall either all products installed in the TIBCO_HOME
directory or just the selected products.

Before you begin

Before uninstalling the product, stop all running AppNodes, BWEngine, and the BWAgents
on the machine on which you want to uninstall the product. Also, close TIBCO Business
Studio™ for BusinessWorks™.

Procedure

1. To uninstall the product, run the TIBCO Universal Installer
(TIBCOUniversalInstaller) from the TIBCO_HOME/tools/universal_installer/
directory.

2. In the TIBCOlInstallationManager screen, select Uninstall Products from a TIBCO
Home Location, and select the TIBCO_HOME location from the drop-down menu.
Then click Next.

3. Click Next on the Welcome screen.

4. On the Uninstallation Type screen, choose the type of uninstall from the following
options and then click Next.

e Custom Uninstall: Select the products to be removed.

* Typical Uninstall: Removes all the products in the selected TIBCO_HOME folder.

5. If you selected Custom Uninstall, select the products you want to uninstall on the
Product Uninstall Selection screen. Then click Next.

6. Review the product to be uninstalled in the Pre-Uninstall Summary screen, and click
Uninstall to proceed.

7. The installer uninstalls the selected products. When prompted to clean up the /tools
directory, click Yes, clean it up.

8. Click Finish in the Post Uninstall Summary screen to exit the uninstall wizard.
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9. If you have uninstalled all the software under TIBCO_HOME, delete the folders under
the TIBCO_HOME directory.
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TIBCO Documentation and Support Services

For information about this product, you can read the documentation, contact TIBCO
Support, and join TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation
website, mainly in HTML and PDF formats.

The TIBCO Product Documentation website is updated frequently and is more current than
any other documentation included with the product.

Product-Specific Documentation

Documentation for TIBCO ActiveMatrix BusinessWorks™ is available on the TIBCO
ActiveMatrix BusinessWorks™ Product Documentation page.

To directly access documentation for this product, double-click the following file:

TIBCO_HOME/release_notes/TIB_BW_6.9.1_docinfo.html where TIBCO_HOME is the top-
level directory in which TIBCO products are installed. On Windows, the default T/BCO_
HOME is C:\tibco. On UNIX systems, the default TIBCO_HOME is /opt/tibco.

The following documentation for this product is available on the TIBCO ActiveMatrix
BusinessWorks™ page:

The following documents for this product can be found in the TIBCO Documentation site:

TIBCO ActiveMatrix BusinessWorks™ Release Notes

TIBCO ActiveMatrix BusinessWorks™ Installation

TIBCO ActiveMatrix BusinessWorks™ Application Development

TIBCO ActiveMatrix BusinessWorks™ Bindings and Palettes Reference
TIBCO ActiveMatrix BusinessWorks™ Concepts

TIBCO ActiveMatrix BusinessWorks™ Error Codes

TIBCO ActiveMatrix BusinessWorks™ Getting Started
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e TIBCO ActiveMatrix BusinessWorks™ Migration

e TIBCO ActiveMatrix BusinessWorks™ Performance Benchmarking and Tuning
e TIBCO ActiveMatrix BusinessWorks™ REST Implementation

e TIBCO ActiveMatrix BusinessWorks™ Refactoring Best Practices

e TIBCO ActiveMatrix BusinessWorks™ Samples

How to Contact TIBCO Support
Get an overview of TIBCO Support. You can contact TIBCO Support in the following ways:

e For accessing the Support Knowledge Base and getting personalized content about
products you are interested in, visit the TIBCO Support website.

» For creating a Support case, you must have a valid maintenance or support contract
with TIBCO. You also need a user name and password to log in to TIBCO Support
website. If you do not have a user name, you can request one by clicking Register on
the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee
subject matter experts to share and access their collective experience. TIBCO Community
offers access to Q&A forums, product wikis, and best practices. It also offers access to
extensions, adapters, solution accelerators, and tools that extend and enable customers to
gain full value from TIBCO products. In addition, users can submit and vote on feature
requests from within the TIBCO Ideas Portal. For a free registration, go to

TIBCO Community.
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Legal and Third-Party Notices

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH EMBEDDED
OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR PROVIDE LIMITED
ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE EMBEDDED OR BUNDLED
SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY OTHER TIBCO SOFTWARE OR FOR
ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS OF A
LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE AGREEMENT,
OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER LICENSE AGREEMENT
WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE SOFTWARE (AND WHICH IS
DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR
CLICKWRAP END USER LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF
THE SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND
YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE
SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of Cloud Software
Group, Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, ActiveMatrix BusinessWorks, ActiveSpaces, Business Studio,
TIBCO Business Studio, TIBCO Designer, TIBCO Enterprise Administrator, Enterprise Message Service,
Rendezvous, and TIBCO Runtime Agent are either registered trademarks or trademarks of Cloud
Software Group, Inc. in the United States and/or other countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle
and/or its affiliates.

This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which is
available at: https://scripts.sil.org/OFL

Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.

All other product and company names and marks mentioned in this document are the property of
their respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. See the readme file for the
availability of this software version on a specific operating system platform.
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THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES
ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED
IN NEW EDITIONS OF THIS DOCUMENT. CLOUD SOFTWARE GROUP, INC. MAY MAKE IMPROVEMENTS
AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT
ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT
NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of Cloud Software Group, Inc. may be covered by registered patents. Please
refer to TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 2023. Cloud Software Group, Inc. All Rights Reserved.
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